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OPC UA Driver Guide About this Guide

About this Guide

This topic contains important information about the purpose, content, context, and intended audience for this
document.

Product Documentation

This document is part of the Niagara technical documentation library. Released versions of Niagara software
include a complete collection of technical information that is provided in both online help and PDF format. The
information in this document is written primarily for Systems Integrators. To make the most of the information
in this book, readers should have some training or previous experience with Niagara software, as well as
experience working with JACE network controllers.

Document Content

This document describes the procedures used to create an OPC UA Server in a station for the purpose of
exposing control points, alarms, and histories to OPC UA clients. This document also describes the procedures
used to create an OPC UA Client in the station which provides connectivity to OPC UA Servers for the purpose
of integrating Opc UA data into the Niagara Framework for monitor and control operation.

CAUTION: Protect against unauthorized access by restricting physical access to the computers and devices
that manage your building model. Set up user authentication with strong passwords, and secure components
by controlling permissions. Failure to observe these recommended precautions could expose your network
systems to unauthorized access and tampering.

Document change log
Changes to this document are listed in this topic.

February 10, 2025
* Added new topic "OPC UA Client Histories" in the "OPC UA client tasks" chapter.
* Added update about OPC UA Server authentication changes with Niagara 4.14.u1 and Niagara 4.15.

January 23, 2024

¢ Added new topic “ Configuring OPC UA Server Security Modes” to the “OPC UA server tasks” chapter.
e Edited topic “Setting up certificate based authentication” to the “OPC UA server tasks” chapter.

¢ Added new topic “Generating an OPC UA server certificate” to the “OPC UA server tasks” chapter.

¢ Added new topic “Generate an OPC UA server certificate for Third-Party Clients” to the “OPC UA server
tasks” chapter.

¢ Edited “Connecting to an OPC UA server” topic in the “OPC UA client tasks” chapter.
¢ Added new topic “Important note about OPC UA Histories” to the “OPC UA client tasks" chapter.
¢ Edited “Generating an OPC UA client certificate” to the "OPC UA client tasks” chapter.

e Edited “Generate an OPC UA Client Certificate for Third-Party Servers” to the “OPC UA client tasks”
chapter.

July 12, 2023

* Added column descriptions for all the manager views.

* Added new topic “Generate an OPCUA Client Certificate for Third-Party Servers” to the “Opc Ua Client
tasks” chapter.

August 22, 2022
Added Discovery Preferences to two topics “Discovering OPC UA Server server points” and “opcUaClient-
OpcUaClientPointDeviceExt."”
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May 24, 2022

¢ In the “opcUaServer-OpcUaServertopic” component topic added “Max Monitored Items Per
Subscription” property description.

e Added new topic “Generating an OPC UA client certificate" to "OPC UA client tasks" Chapter

¢ Created new topic for setting up certificate based authentication.

March 17, 2021
Edited the introductory chapters, and added screen captures and properties to component topics.

October 27, 2020
In the “Connecting to an OPC UA Server” topic added the information about:

* How to set up the security settings and user name and password
* And in the “Third-party simulation software” updated OPC foundation’s Sample Applications download.

October 25, 2019
In the topic, “About this guide”, added a caution note alerting customers to restrict access to all computers,
devices, field buses, components, etc., that manage their building model.

December 19, 2017
Initial publication.

Related documentation
This topic lists documents that are related to this guide.

e Niagara Drivers Guide

* Niagara Platform Guide
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Chapter 1. Overview

OPC is the interoperability standard for secure and reliable data exchange in the industrial automation space,
as well as other industries. The OPC standard is a series of specifications that define the interface between
clients and servers, as well as servers and servers, including access to real-time data, monitoring of alarms and
events, access to historical data and other applications.

The OPC standard, initially restricted to the Windows operating system, derives its acronym from OLE (object
linking and embedding) for Process Control. These specifications are now known as OPC Classic. The OPC
Unified Architecture (UA) is a platform-independent, service-oriented architecture that integrates the
functionality of the individual OPC Classic specifications into an extensible framework.

The Opc UA Driver is the Niagara implementation of this service-oriented architecture.

Driver component model

Niagara provides a set of two OPC UA drivers: opcUaClient and opcUaServer. Both follow the Niagara
Framework®model for drivers.

The OPC UA specification provides a platform-independent, service-oriented architecture. It integrates all
functionality from the existing OPC Classic specification, providing a more secure and scalable solution. The
specification is backwards compatible with OPC Classic.

OpcUaServer driver component model

The two main components are the OpcUaServer and OpcUaNamespace. The OpcUaServer component models
an OPC UA server instance in the driver framework. There should be only one instance of this driver in a
station.

The OpcUaServer component models an Opc UA namespace in the parent OPC UA server. It typically provides
a logical grouping of OPC UA variables, histories, and events that can be accessed by an OPC UA client.

OpcUaClient driver component model
The primary OpcUaClient components are:

* OpcUaNetwork serves as the parent container for all of OPC UA client devices.
* OpcUaDevice represents an OPC UA client.

* OpcUaClientPointDeviceExt contains proxy control points used to proxy values to and from the OPC UA
server.

* OpcUaClientAlarmDeviceExt subscribes the station to alarm events from the OPC UA server.
* OpcUaClientHistoryDeviceExt imports histories from the OPC UA server.

* OpcUaClientProxyExt is the control point proxy ext used to identify a specific OPC UA server data
variable to proxy through this control point.

* ImportHistoryExt is the history point extension that imports the history data associated with the specific
OPC UA server data variable defined in the proxy ext.

Supported profiles

* UA Generic Client Profile

e UA Data Access Client Profile

e UA History Data Access Client Profile
e UA Alarm

Supported facets
The following table lists the OPC UA client facets supported by the Niagara OPC UA drivers. This is a subset of
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available OPC UA facets.

OPC UA Facet Description

Defines client behavior for best use by operators and administrators. These behaviors include the
ability to configure an endpoint for a server without using the discovery service set; support for
manual security configuration and behavior with regard to security issues; support for automatic
reconnection to a disconnected server.

Base Client Behavior Facet

Defines the core functionality required for any client. This Facet includes the core functions for

ore Client Facet . . .
G security and session handling.

Defines the ability to navigate through the AddressSpace and includes the basic AddressSpace

AddressSpace Lookup Client Facet concepts: view and browse, and simple attribute read functionality.
Attribute Read Client Facet This Facet defines the ability to read Attribute values of Nodes.

DataChange Subscriber

. This Facet defines the ability to monitor Attribute values for data change.
Client Facet

This Facet defines the ability to utilize the DataAccess Information Model, i.e., industrial automation

Delevieazes Clant Fees data like analog and discrete data items and their quality of service.

Partially supported.

This Facet defines the ability to subscribe for Event Notifications. This includes
basic AddressSpace concept and the browsing of it, adding events and event
filters as monitored items and adding subscriptions.

Alarm and Event Client Facet

Method Client Facet This Facet defines the ability to call arbitrary Methods.
Historical Access This Facet defines the ability to read, process, and update historical data.
Requirements

The OPC UA drivers require licensing and a set of core modules.

Platforms and software

The OPC UA drivers function on any QNX-based platform running on latest Niagara version, such as the
JACE-8000, as well as Windows-based platforms (Windows 7 Service Pack One and later) running on latest
Niagara version.

The OPC UA drivers function on any Ubuntu Core 20 platform running on latest Niagara version, such as the
JACE-9000, as well as Windows-based platforms (Windows 7 Service Pack One and later) running on latest
Niagara version.

In addition to the framework software, the OPC UA server requires software, such as Prosys OPC UA
Simulation Server, installed on your PC. You use this to configure and manage the OPC UA server.

License requirements
The opcUaClient module requires a license for the “opcUaClient” feature. This license may have other OPC UA
client device, proxy point, and history limits.

The opcUaServer module requires a license for the “opcUaServer” feature. This license may have other OPC
UA client device, proxy point, and history limits.

To check to see if your software installation is licensed for opcUaClient and/or opcUaServer, open the license
file from the License Manager view. The feature name is present only if your platform is licensed for the

feature, as shown here:

&lt; feature name="opcUaClient" expiration="2020-12-31" history.limit="" point.limit="" device.limit=""/ &gt;
&lt; feature name="opcUaServer" expiration="2020-12-31" history.limit="" point.limit="" device.limit=""/ &gt;

Server modules
The server driver requires these modules in the host station:
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e opcUaCore-rt contains Java Class files and resources common to both OPC UA client and OPC UA server
functionality.

e opcUaServer-rt contains Java Class files and resources that support OPC UA server run-time functionality.

e opcUaServer-wb contains Java Class files and resources that support OPC UA server Workbench
functionality.

Client modules
The client driver requires these modules in the host station:

* opcUaCore-rt contains Java Class files and resources common to both OPC UA client and OPC UA server
functionality.

* opcUaClient-rt contains Java Class files and resources that support OPC UA client run-time functionality.

* opcUaClient-wb contains Java Class files and resources that support OPC UA client Workbench
functionality.

Third-party simulation software

Third-party OPC UA simulation servers and client devices are available for purposes of testing and evaluation.
This section provides a few links.

If installing only the client driver, you will need to identify an OPC UA server for the client driver to
communicate with. Following are a couple simulators that are available.

® Prosys OPC UA Simulation Server download: https://prosysopc.com/products/opc-ua-
simulation-server/

* OPC Foundation Sample Applications download: https://opcfoundation.org/products/view/
opc-ua-server-simulator

If installing only the server driver, you will need to identify an OPC UA client device for the server driver to
communicate with. Following are a couple of clients that are available.

® Prosys OPC UA Client download: https://www.prosysopc.com/products/opc-ua-client/
evaluate/

* Unified Automation's UA Expert OPC UA Client download: https://www.unified-automation.com/
downloads/opc-ua-clients.html

Related tasks
Verifying server setup using client simulation software

About the security architecture

The OPC UA security architecture is structured in an application layer and a communication layer on top of the
transport layer.
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Figure 1. OPC UA security architecture

OPC UA Client OPC UA Server
Application Layer Application Layer
« User Authorization Session « User Authorization
« User Authentication - « User Authentication
Communication Layer <« » Communication Layer
« Confidentiality Secure Channel « Confidentiality
= [ntegrity * |ntegrity
 App Authentication + App Authentication
Transport Layer

A session in the application layer transits information, settings and commands between a client application and
a server application. The application layer also manages security objectives, user authentication and user
authorization. The application layer communicates over a secure channel in the communication layer and relies
upon it for secure communication. The secure channel provides encryption to maintain confidentiality, message
signatures to maintain integrity and digital certificates to provide application authentication for data from the
application layer, which it securely passes to the transport layer.

Security profiles

In the Niagara OPC UA implementation the combination for security mode and security policy form a security
profile. Different profiles specify different details, such as which encryption algorithms are required for which
OPC UA functions. Some of the profiles specify security functions and others specify other functionality that is
not related to security.

A Sign with Security Policy profile offers these options:

* SignBasicl28RSA15 provides medium channel security during commutation. It transports messages as
plain text with a digital signature.

® SignBasic256 provides medium to high channel security during commutation. It transports messages as
plain text with a digital signature.

* SignBasic256SHA256 provides high channel security during commutation. It transports messages as plain
text with a digital signature.

A Sign and Encrypt with Security Policy profile offers these options:

* SignEncryptBasicl28RSA15 provides medium channel security during communication. It encrypts
messages transports the data with a digital signature.

® SignEncryptBasic256 provides medium to high channel security during commutation. It encrypts
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messages and transports data with a digital signature.

* SignEncryptBasic256SHA256 provides the highest channel security during commutation. It encrypts
messages and transports data with a digital signature.

NOTE: The default profile for OPC UA is Sign and Encrypt with Security using the
SignEncryptBasic256SHA256 option for Security Mode.

The other profiles include a warning message that points out the security risk involved. You or an administrator
must acknowledge the warning, which the driver logs in the system for audit purposes.
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Chapter 2. OPC UA server tasks

Setting up an OPC UA server involves configuring properties, adding server points with alarm and history
extensions, and configuring OPC UA client users.

OPC UA server, client user authorization

Starting with Niagara Niagara 4.14.u1 and Niagara 4.15, the OpcUaServer component provides access to
specific aspects of the OPC UA Server based on user roles and permissions as they are configured in the User
Service, Role Service and Category Service. These server-side settings are observed when granting access to
specific aspects of the OPC UA Server and include more restrictive access for Anonymous users.

The Niagara OpcUaServer component performs user name and password authentication for users that are
created and configured in the Niagara user service. In versions prior to Niagara 4.14.u1 and Niagara 4.15, this
component does not consider the user roles and permissions as configured in the User Service, Role Service
and Category Service when granting access to specific aspects of the OPC UA Server. Also, in the earlier
versions, Anonymous users have the ability to subscribe to (monitor) point values.

Starting with Niagara 4.14.u1 and Niagara 4.15, based on individual user configuration, an OPC UA Client user
experiences the following:

* the user sees only those points and point properties (including units, etc.) where read access is allowed.

* the user writes to only those points and point properties (including units, etc.) where write access is
allowed.

* the correctly specified user access level types and restrictions are communicated to the Opc Ua client.

Breaking change on version upgrade

OPC UA Server configurations prior to Niagara 4.14.u1 and Niagara 4.15, that rely on username and password
authentication might start to see User Access Denied errors if the users are not assigned appropriate roles
and permissions in the User Service. In addition, existing read subscriptions or monitors for Anonymous users
will start to fail.

Resolution
To resolve issues caused by the software update, configure any users that are created for OPC UA
authentication with appropriate roles to access specific components of the driver tree.

Setting up the OPC UA server

Setting up an OPC UA server follows a standard framework procedure.

Prerequisites:

* The opcUaCore and opcUaServer modules are in the My Modules folder.

* The controller is licensed with the opcUaServer feature.

* You are connected to the Internet and working in Workbench running on a PC or laptop computer.

* The controller to use is on the network and powered on.
NOTE: If you intend to install only the OPC UA client driver, skip ahead to the chapter, “OPC UA client tasks.”

The example client used in this procedure is the ProSys Simulation OPC UA Client. Many other third-party
simulation OPC UA clients are available, which you can use to connect to an OPC UA server.

Step 1. Connect to the controller station.

Step 2. Open the opcUaServer palette (click the folder icon in the Palette sidebar).
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Step 3. Drag the OpcUAServer component from the palette to the Config > Drivers folder in the station.
The driver adds the server to the station and enables it by default.The server Status likely reports
{ok}.

Step 4. To add a namespace (a container for point IDs), do one of the following:

e Drag an OpcUaNamespace component from the palette to the OpcUaServer node in the
Nav tree.

* Double-click OpcUaServer (this opens the Opc Ua Server Device Manager) and click New >
OK.

A second New window opens. It contains several properties.

Step 5. Configure the namespaceName or use the default name and click Save.
You can leave the rest of the properties at their default values.
The driver adds the new namespace to the Opc Ua Server Device Manager. If you are updating
the existing namespace, the changes will be reflected once the server restarts.

Step 6. To retrieve the server’s connection address, right-click the OpcUaServer node in the Nav tree and
click Views > AX Property Sheet.
The property sheet opens.

(@l Opc Tep Endpoint Opc Tcp Endpoint
(@l User Authentication Methods [ Anonymous [#] Username/Password
. Max Session Count 500

M Max Session Timeout [ FUULUU

(g Max Subcription Count 50
| . Opc Tcp Connection Address opc.tep: //IE3BLT1GESAC2 . global . ds. honeyw
(M Server Info Opc Ua Build Info

0 Session Info Mo active sessions

Step 7. Locate and make a note of the server's Opc Tcp Connection Address.
Any OPC UA client attempting to connect to the server requires this connection address.

NOTE: The port specified in the Opc Tcp Connection Address may be blocked by your PC/
network firewall. The firewall settings may need to be adjusted to allow data transfer on this port.

Result

The OPC UA server set up is complete. For any OPC UA client connection to succeed, the client must be
configured with the server’s Opc Tcp Connection Address, as well as a Security Mode, Security Policy,
and User Authentication method as required by the server.

Username and password values also must be defined in the station’s UserService.

Related reference

* opcUaServer-OpcUaServer
* opcUaServer-OpcUaNamespace
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Configuring OPC UA Server Security Modes

Starting with Niagara 4.14 to secure data, you need to configure the Security Mode and the Server Security
Certificate used by the server to sign and encrypt communication messages. You must select the Server
Security Certificate from the Niagara Key Store.

Prerequisites:

OPC UA server tasks

e A self-signed certificate, or a CA signed certificate in the User Key Store is required for this procedure. For

more details refer the “Generating an OPC UA Server Certificate” .

* Niagara 4.14 or later version is required to support certificate-based authorization.

Step 1. Inthe Workbench Nav tree, expand Config > Drivers, right-click the OpcUaServer and click Views
> Property Sheet.
The Property Sheet opens.

: Config * Drivers : OpcUaServer 7
~ Nav Property Sheet
# o @ My Network (4] OpcUaserver (Opc Ua Server)
- Ul Status {ok}
© config (@ Enabled @ true
@ services (M Fault Cause
O orvers L3 Health Ok [15-Dec-23 5:14 PM IST]
@ niagaraNetwork © Alarm Source Info Alarm Source Info
 opcuaserver 3 Monitor Ping Monitor
@ OpcUaNamespace X Tuning Policies Tuning Policy Map
© apps f« Poll Scheduler N Poll Scheduler
Q Files i Opc Ua Server Name N40pcUaServer
Hierarchy (@ Cert Alias And Password default
@ History [l Alias default
. Password [J use global certificate password
- Opc Tep Endpoint Opc Tep Endpoint
- Enabled @ true
(@ Port 52520

(@ Security Mode [ none 4 sign [ signEncrypt
(W Security Policies  [#] Basic128Rsa15 [@] Basic256 @] Basic2565ha256
[l User Authentication Methods [ Anonymous [# Usemame/Password [] Certificate

(M Min Worker Threads 8 [8-max]

 Refresh [ save

Step 2. Click the check box to select the Security Mode and Security Policies.
NOTE: It is recommended to use the SignEncrypt mode and Basic256Sha256 policy for
high security.

Step 3. Inthe Cert Alias And Password property, click the drop-down Alias to select the Server
Security Certificate and enter the private key Password.

Step 4. To save your changes, click Save.

Configuring the server to support an OPC UA client user

OPC UA clients require you to configure an authentication scheme. This scheme assures that the identity of
each user can be verified. It may use roles to limit user access to only certain areas. The scheme authenticates
the user when he or she enters a username and password, which are already configured for the user.

Prerequisites:
* You are connected to a running station that is configured with the OpcUaServer.
* The opcUaServer palette is open.

February 3, 2025 15



OPC UA server tasks OPC UA Driver Guide

NOTE: When making any server-side changes, you must first disable and then re-enable the server.

Step 1.

Step 2.

Step 3.

Step 4.

Step S.

Step 6.

Step 7.

Step 8.

Step 9.

Step10.

In the Nav tree, expand Config > Drivers, right-click OpcUaServer and click Views > AX Property
Sheet.
The server’s AX Property Sheet opens.

Under the Enabled property, click the drop-down list and click false.
The driver disables the OpcUaServer.

In the Nav tree, expand Config > Services > AuthenticationService.

0 AuthenticationService
@' Authentication Schemes
. DigestScheme
. A¥DigestScheme
F. OpcUahuthenticationScheme
. 550 Configuration

Drag the OpcUaAuthenticationScheme component from the opcUaServer palette to the station’s
Authentication Schemes subfolder.

Expand Config > Services and double-click UserService.
The User Manager opens.

To add a single new user, click New and click OK.

A second New window opens.

Configure these properties and click Ok.:

* For Name enter the user’s name.

* For Authentication Scheme Name, select a scheme from the drop-down list.

* For Password, create a strong password and enter it a second time in the Confirm property.
A strong password requires at least ten characters, plus at least one of each of the following
characters: lowercase, uppercase, and a digit.

If you use the same default password for all new users set the Force Reset At Next Login value
to true.

To enable the server, expand Config > Drivers, right-click OpcUaServer and click Views > AX
Property Sheet.
The AX Property Sheet opens.

Set Enabled to true and click Save.
The server is ready to support an OPC UA client user.

Related reference

opcUaServer-OpcUaAuthenticationScheme

Setting up certificate based authentication

Certificate-based authentication is a technique that allows one machine to securely identify itself to another
across a network connection, using a certificate called a public-key certificate.

Prerequisites:

* You need to have CA and Intermediate certificates, or a self-signed certificate to use in this procedure.

16
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Refer to the “Generating an OPC UA Client Certificates” for instructions.

¢ Niagara 4.14 or later version is required to support the latest client certificate authentication in the OpcUa
Server driver.

Using Signed Certificates

Step 1. Import the CA and Intermediate certificates into the User Trust Store of the station’s
CertManagerService and the User Trust Store of Workbench.

Step 2. Create a client certificate in the station’s CertManagerService and sign the client certificate by any
one of the CA or Intermediate certificates.

Step 3. Export public key and private key of the client certificate.

Step 4. For further communication with the server, send the public key and private key file to client. By
default, the public key is in PEM format. The client needs to convert the public key into the
required format by using openssl command and use that certificate as the user identity credential.

Using Trusted Self-Signed Certificates
Step 1. Import the client certificate into the User Trust Store of the station’s CertManagerService.

Step 2. Create a connection from the client using that certificate as the user identity credential.

Using Self-Signed Certificates from an allowed host
Step 1. Attempt a connection from the client using a certificate as the user identity credential.

Step 2. Approve the certificate exemption from host in the Allowed Hosts section of the station’s
CertManagerService.

Step 3. Ping the server from the device again to establish connection.

OpcUaServer alarm processing
When started, the OPC UA server automatically adds to the station's AlarmService OpcUaServerAlarmClass
and OpcUaServerAlarmRecipient components (if they do not already exist).

The driver routes an OPC UA event from the Niagara alarms to the OpcUaServerAlarmRecipient via the linked
OpcUaServerAlarmClass. Alarms routed to the recipient must come from a control point that also contains a
server proxy extension. The OpcUaServerProxyExt relates the OpcUaServerAlarmRecipient to a UA Node Id.
This UA Node Idis a property of the OpcUaServerProxyExt.

The OpcUaServerAlarmRecipient also has an Opc Ua Severity property. This property maps the alarm's
Alarm State to the OPC UA alarm severity index.

The following image shows the default Opc Ua Severity mapping.

© Opc Ua Severity 700, 900, 500, 600

i To Offnormal |? 00 |[1 - 1000]
@ To Faul looo |[1 - 1000]
i To Normal |5|:|-[} |[1 - 1000]
@ To Alert l600 |[1 - 1000]
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Adding a server point with alarm and history extensions

Server points provide live and historical data as well as alarm events. Server points are visible to connected
OPC UA clients.

Prerequisites:
* You are connected to a running station that is configured with the OpcUaServer.
* The opcUaServer palette is open.

* The station does not already have control points available.

NOTE: Adding a history extension to a control point in the OPC UA server's namespace makes the associated
history visible to a connected OPC UA client. Similarly, adding an alarm extension to a control point in the OPC
UA server's namespace and setting the alarm extension's Alarm Class to OpcUaAlarmClass sends OPC UA
events to a connected OPC UA client that subscribes to these events.

Step 1. Inthe Nav tree, expand Config > Drivers > OpcUaServer > OpcUaNamespace.

|

~ Nav E|

|=@ O @ My Metwork

6 OpcllaSernver
ﬂ OpclaMamespace
O Alarm Source Info

e Paints

FA opclaServerPointFolder

Step 2. From the palette, add an OpcUAServerPointFolder to the Points container.

Step 3. Under the station’s Config > Drivers folder, add a new NumericWritable point. Configure it with a
NumericCov history extension and an OutOfRangeAlarmExt.

Step 4. To open the Opc Ua Server Point Manager, double-click the OpcUaServerPointFolder, click
Discover, then, in the ORD property, select the folder to search and click OK.
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The Discovered pane presents a list of control points that exist in the station. You can map these
to the OpcUaServerPointFolder.

: Ststion(OpcUa_01)  : Config  : Drivers  : OpcUaServer  ° OpclUaNamespace @ Points  © OpcUsServerPointFolder /'  OpcUaServerPoint Manager +

- Nav o ] Logic [l OpcUaserverPointFolder [E3]

K O ) My Network @ ./ CpcuaServer Discovery success 3 [%]

© opcuaserver Discovered & objects

m OpcUaNamespace Point Direction  Point Type &
o Alarm Source Info

e Points

Al opcuaserverPointFolder

slot:/Logic/NumericWritable 01  Export control:NumericWritable
n slot:/Logic/SineWave_01 Export kitControl:SineWave
o nslot:r'Log\:"MuLthlhrator Export kitControliMultivibrator
NumericWritable_01
Numerichritable_02 sloti/Logic/BooleanWritable_01  Export control:BooleanWritable
@ eooleanwritable_o1 BAsiot:/Lozic/Random 02 Export KitControl:Random
o Alarm Ext Database 3 objects

6 opcuanetwork Name Out Ua Node Id Local Point R

NumericWritable_01 62.2 [unackedAlsrm} @16 ns=2:s=points/OpcUaserverPointFolder/NumericWritable_01  slot:/Logic/NumericWritable_
- Palette

0r-lumeru:'h'.‘ritableg}:-‘. 88.6{alarm,unackedAlarm} @ 16 [ns=2;s=points/OpcUaServerPointFalder/NumericWritable_02 |slot:/ /NumericWritable
W X 3 |8 opcvaserer 0 BooleanWritable 01  true{ok} @16 ns=2;s=points/OpcUaServerPaintFolder/BooleanWritable 01  slot/Logic/BooleanWritable_
A OpcUaServerPointFolder

A OpcUaAlarmClass
&g OpcUailarmRecipient

M New Folder | [ New | & Fdit  § Discover W cancel (B Add | b Match | @ Tagit

Step 5. Select the NumericWritable in the Discovered pane and click Add.
The driver adds the point to the Database pane where it becomes visible under the
OpcUaServerPointFolder.

By default, the driver exports a discovered writable point from the server as read-only. However,
you can add a writable point that you can import. The driver imports the point (which the client
writes) to the server. The server reads the data from the client.

After adding the point in the server, you can add history or alarm extensions to enable histories
or alarms for the point.

Step 6. To do this, expand the writable point in the Discovered pane, select the point with a Direction
value of Import and click Add.

Result
The driver serves up the server points in this OpcUaServerPointFolder as consumable data including live and
historical data and alarm events. These data are visible to a connected OPC UA client.

Related reference

opcUaServer-OpcUaServerAlarmDeviceExt

Verifying server setup using client simulation software

This procedure uses the ProSys OPC UA Client software to verify the OPC UA server setup. Several other OPC
UA clients are available. The procedure remains basically the same for all clients.

Prerequisites:

* You are connected to a running station that is configured with the OpcUaServer.
* OPC UA client simulation software is installed.

* The station does not already have control points available.

® You have an Internet connection.

* Client user credentials (username and password) exist in the station’s UserService.
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Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

20

Expand Config > Drivers, right-click OpcUaServer and click View > AX Property Sheet.
The AX Property Sheet opens.

Max Subcription Count 50
E Opc Tep Connection Address opc.tcp: //IE3BLT1GKSEC? . global . ds . honeyw
(M ServerInfo Opc Ua Build Info

Copy the Opc Tep Connection Address.
NOTE: The port specified in this address may be blocked by the PC/network firewall. The firewall
settings may need to be adjusted to allow data transfer on this port.

Open the simulation software.
The Prosys OPC UA Client window opens.

F ™y
3 Prosys OPC UA Client [E=SRER o
[(NewTab | ¢

Disconnected | OpC.tep:/ Ml E L, | L ds.honeywell.com:SZSNfDPCUNNdecUaSenrerl I ‘V :.‘) @' @ ?
1 i T

v Attributes and References | 4
B T < [ [ ]Forwars E
: Reference | TargetDisplayMame

Select server and connect

Paste the Opc Tcp Connection Address into the available field and click the security options

button ( &/ ).

The Security Settings window opens.

rg Security Settings ﬁw

s — Security Policy
ecun e
ty 3 None
i) Mone Ok
O s " Basic128RSA15
ign
(s Basic256 Cancel

@ Sign & Encrypt
® Basic256SHA256

] Show only modes that are supported by the server

Select the Security Mode and Security Policy settings required by the server, for example
Sign & Encrypt and Basic256SHA256, and click Ok.
The focus returns to the Prosys OPC UA Client window.
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Step 6. To define the user, click a user ID button ( |/ ).
The Select User Authentication Mode window opens.

g Select User Authentication Mode @

i) Anonymous ® Username and Password ) Certificate and Private Key Apply Cancel

Username: |opcllalser Password: esessssses

Step 7. Select a user authentication mode as required by the server, for example: Username and
Password, enter a valid Username and Password and click Apply.
The focus returns to the Prosys OPC UA Client window.

Step 8. To connect to the server, click the connect button (=) ).
The client connects to the OPC UA server.

[ Prosys OPC UA Client J [E=REE

N4OpcUaServer@«&l& I &0 &1 1 global.ds.honeywell.com L]

|

4| Attributes and References | Data View X | &
[ ﬁ Objects [v] Enabled Publishinglnterval|1000.0
9 W OchQNamespace # Mode Id Display Mame | Value | Datatype Source Timestamp Server Timestamp Statuscode
# @ points )0 |ns=2;s=poi.. [NumericWritable |99.242..[Number _ [14.03.2017 17:01:14.0..[14.03.2017 17:01:14.... |GOOD (0x00...
? @OchaSeNerF’ointFolder 2

o= “_1 BooleanWritable
o= | NumericWritable
o= ﬂ Server

o Types
Views

In the example, expanded Objects reveal the OPC UA namespace with server points. The right-
side Data View tab monitors data values for the selected points.

Related reference

Third-party simulation software

Generating an OPC UA server certificate

The topic explains how to generate a server certificate using the added URI field in the certificate to establish a
secure server connection from the client to the server.

Prerequisites:
* The certificate is used for OPC UA users only.
e Workbench running on a PC or laptop computer.

Step 1. To generate a certificate, expand Station > Config > Services > PlatformServices and double-click
CertManagerService
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The Certificate Management view opens.

~ Nav

t# O

G) My Network

» o OrionAlarmService
w v PlatformServices
6 TcplpService
o LicenseService
o CertManagerService
v 6 Drivers

> e NiagaraNetwork

» @ roints
» °H|stories

» [i serverRoot

Step 2. Click the New button at bottom of the view.

: Config

. Services . PlatformServices

CertManagerService
Certificate Management

Certificate Management for "localhost”

User Key Store  System Trust Store User Trust Store Allowed Hosts

You have local certificates:

User Key Store

Alias Subject  Not After Key Algorithm  Key Size Valid
tridium Niagarad SatNov0517:17:051ST2022 RSA

2048 true

New Eﬂ Cert Request

[ import | [2 Export X R

OPC UA Driver Guide

7

Certificate Management ~

@ Delete
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The Generate Self Signed Certificate window opens.

Generate Self Signed Certificate X

==| Generate Self Signed Certificate

= | Generates a self signed certificate and insertsitinto the keystore

Alias OPCUA (required)

Common Name (CN) OPCUA (required)
*this may contain the host name or address of the server

Organizational Unit (OU)

Organization (0) Acme (required)

Locality (L)

State/Province (ST)

Country Code (C) IN (required)

Not Before
Not After

Key Size

Certificate Usage
Alternate Server Name
Alternate Server URI
Email Address

Key Usage

09-Jan-2024 04:43 FM I5T j
08—Jan-2025 04:43 PM IST i"

1024 bits ¢ 2048bits  3072bits > 4096 bits
® Server O Client $ CA $ Code Signing

3.global.acmecorp.com:0PCUA:N4OpcUaServer

Digital signatu

re [ Non-repudiation Key encipherment

[ ] cRLsigning ] Encipheronly ] Decipheronly

oK

| Cancel

Step 3. Give the certificate at least an Alias, Common Name (CN), Organization, Locality, State/
Province, and Country Code.
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Step 4.

Step 5.

Step 6.

Step 7.

* Use Alias to identify this as an OPCUA certificate.

® The Common Name (CN) becomes the Subject (also known as the Distinguished Name). For
OPCUA certificate, the Common Name (CN) may be the same as the Alias.

* Organization is the name of the company.

e Although Locality and State/Province are not required, leaving them blank generates a
warning message.

® The two-character Country Code is required and must be a known value, such as: US, IN, CA,
FR, DE, ES, etc. (refer to the ISO CODE column at countrycode.org).

* Not Before and Not After define the period of validity for the certificate.

* For Certificate Usage, the radio button should be set to Server.

Enter the URI in the Alternate Server URI field; it should be in the format:
urn:<full.computer.name>:0PCUA:N4OpcUaServer and the select checkbox in the Key
Usage set to Data enchipherment in the certificate.

NOTE:

* The full computer name can be found in Control panel > System & Security > System; it is of
the type hostname.domain or just hostname in some cases.

¢ While connecting from client to server, the URI provided in the client certificate should match
in the Application URI for the server. If doesn’t match the URI, it sends an error message as
Bad CertificateUriInvalid 0x80170000. The URI specified in the
Application Description does not match the URI in the certificate.

When you have filled in the required fields, click OK.
The Private Key Password window opens.

Private Key Password X

Private Key Password
Private Key Password

Password |

Confirm

[[] use global certificate password

0K Cancel

Enter and confirm the password, then click OK.

The system submits the certificate for processing in the background. A pop-up window appears
on your screen advising you regarding it may take time to generate the certificate. The length of
time it takes depends on the key size and the platform’s processing capability. When created, the
certificate appears as a row in the User Key Store table.

To configure the certificate, open the device’s Property Sheet by right-clicking on OpcUaServer
followed by clicking View > Property Sheet.
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The Property Sheet view opens.

Station (TestOPCUA) : Config 5 : OpcUaServer / Property Sheet ~

- Nav Property Sheet

tf O @ My Network e OpcUaServer (OpcUa Server)

&) My File System
0 My Modules
& Platform
H Station (TestOPCUA)
‘ Alarm
6 Config
@ Services
6 Drivers
e NiagaraNetwork
6 OpcUaServer
; OpcUaNamespace
6 OpcUaNetwork
@ Apps
@ Files
@ Hierarchy

@ History

l Status

. Enabled

l Fault Cause

] Health

° Alarm Source Info

L3 monitor

X Tuning Policies

l" Poll Scheduler

(M OpcUa Server Name

[l Cert Alias And Password
(W Alias opcua
@l Password ~ eeeesssess

i Opc Tep Endpoint

(M User Authentication Methods
[l Min Worker Threads

Ul Max Session Count
Ul Max Session Timeout

. Max Subcription Count

[l MaxMonitored Items Per Subscription

. Opc Tcp Connection Address
(M Server Info

O Session Info

E OpcUaNamespace

{ok}

@ true

Ok [09-Jan-24 5:18 PM IST]
Alarm Source Info

Ping Monitor

Tuning Policy Map

N Poll Scheduler
N4OpcUaServer

opcua

|:| Use global certificate password

Opc Tcp Endpoint

[ Anonymous [[] Username/Password [#] Certificate
8 [8-max]

500

50

10000
opc.tcp://

Opc Ua Build Info
No active sessions

Opc Ua Namespace

{ Refresh [) save

Step 8. Expand Cert Alias And Password property, select the certificate from the Alias drop-down menu,
enter the private key Password and click Save.

Generate an OPC UA server certificate for Third-Party Clients

The topic describes how to generate a server certificate using scripts by running the appropriate commands in
the command prompt or Git Bash to establish a secure server connection from the client to the server. To
ensure compatibility with OpcUaClient implementation, automatically uses a certificate for signing purposes
with the keyCertSign usage while generating the certificate.

Prerequisites:

® OpenSSL is installed on your system so that you can use the script file from the default windows command

line.

¢ Niagara station is running.

e The hostname is the full device name. To find the full device name in the Windows menu, choose Start >
Settings > System > About, and in Device Specifications you can find Full device name or from a
command line, type the following net config workstation, and you can find the string Full Computer name.

Step 1. To generate a certificate, follow one of the choices below.

* If you are using windows, open the command prompt, type the following command and

press Enter.

gen-opc-server-cert.bat

* If you are using Git Bash application, open the Git Bash prompt, type the following
command and press Enter.

./gen-opc-server-cert.bat
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¢ If you are using Linux or WSL, open the command prompt, type the following command and
press Enter.

gen-opc-server-cert.sh

Prompts should appear in the Command Prompt (Terminal or Shell) window.

Step 2. Follow the instructions displayed in the window, type the client hostname and press Enter.

C:\Users\ "\Documents>gen-opc-server-cert.bat

Enter the server hostname [ ]: Acme.com

Enter certificate validity in days [365]: 84

Enter destination file [.\server.pem]: .\demo.pem
B g I B o S

ou are about to be asked to enter information that will be incorporated
into your certificate request.
What you are about to enter is what is called a Distinguished Name or a DN.

There are quite a few fields but you can leave some blank
For some fields there will be a default value,
If you enter '.', the field will be left blank.

Country Name (2 letter code) [US]:IN

State or Province Name (full name) []:Karnataka

Locality Name (eg, city) []:Bengaluru

Organization Name (eg, company) []:Acme

Organizational Unit Name (eg, section) []:Engineering

Common Name (e.g. server FQDN or YOUR name) [Acme.com]:OPCUA
Email Address []:XYZ@Acme.com

Cert written to .\demo.pem

Step 3. Type the certificate validity in days and press enter.

NOTE: Based on requirements, you can specify duration for certificate validity.
Step 4. Type the destination file name in the format .\yourCertName.pem and press Enter.

Step 5. Type arandom PEM Pass Phrase, press enter and verify the PEM Pass Phrase, press Enter.

The PEM passphrase can be any random passphrase with sufficient strength. Use the same PEM
passphrase throughout the procedure.

Step 6. Type the following information and press Enter after each step.
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¢ The two-character Country Code is required and must be a known value, such as: US, IN, CA,
FR, DE, ES, etc. (refer to the ISO CODE column at countrycode.org).

® State/Province

® Locality Name

* Organization Name is the name of the company.

® Organizational Unit Name

® Common Name (CN)

®* Email Address

It displays Cert written to the destination and generates a certificate in the given destination file.
Step 7. To import the PEM certificate, open Workbench, expand Config > Services > PlatformServices,

and click CertManagerService.

a. In the Certificate Management view, click Import, browse to the destination file and enter
the password for decrypting the private key.

Private Key Password X

Private Key Password
Please enterthe password for decrypting the private key contained in the importfile.

Password |

oK Cancel
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Certificate Import

Certificate Import
Information forimported certificate OPCUA

EnterAlias

Tableview  ASN.1View

Properties:

Version

Serial Number
lssued By

IssuerDN

Subject

Subject DN

Not Before

Not After

Key Algorithm

Key Size

Signature Algorithm
Signature Size

Basic Constraints
Key Usage

Extended Key Usage
MDS5 Fingerprint

PEM View

v3

7f 0d b% bl 5a £3 €9 e0 2b c0 3% 08 c3 a7 Oc c2 e4 11 35 92
OFCUA

C=IN,ST=Karnataka, L=Bengaluru,O=Acme, OU=Engineering, CN=0PCUA, E=
OPCUA
C=IN,S5T=Karnataka, L=Bengaluru, O0=Acme, 0U=Engineering, CN=0PCUA, E=
Mon Jan 08 12:54:47 IST 2024

Mon Rpr 01 12:54:47 IST 2024

RSA

2043

SHR2S56WITHRSA

256

Subject Type: End Entity

keyEncipherment, nonRepudiation, digitalSignature, dataEncipher
TLS Web Server Authentication (1.3.6.1.5.5.7.3.1), ILS Web Clie
62:32:76:0£f:cl:3b:ba:9%b:£f7:b3:3d:£7:43:48:£7:20

0K Cancel

The Certificate Import wizard opens.

b. To change the existing Alias, enter the new Alias name or continue with the existing Alias
and click OK.

Private Key Encryption Password

Private Key Encryption Password
Please enter the password forencrypting the private key when savingitinto the key store,

Password |

Confirm

0K | Cancel

The Private Key Encryption Password window opens.
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c. Type the Password, verify the Confirm password for encrypting the private key when saving
it into the key store and click OK.
The certificate appears as a row in the User Key Store table.

Step 8. To configure the certificate, open the device’s Property Sheet by right-clicking on OpcUaServer
followed by clicking View > Property Sheet.

~ Nav

t O OMyNemork

° My File System
0 My Modules
BT Platform
, Station (TestOPCUA)
! Alarm
v e Config
> @ Services

v e Drivers

b € NisgaraNetwork
» e OpcUaServer
» e OpcUaNetwork
> e Apps
» Q Files

» @ Hierarchy

. Config . Drivers

Property Sheet
e OpcUaServer (Opc Ua Server)
[l status
(M Enabled
(@ Fault Cause
3 Health
© Alarm Source Info
Q Monitor
X Tuning Policies
e Poll scheduler
i Opc Ua Server Name
[W Cert Alias And Password
(W Alias demo
[l Password
i Opc Tep Endpoint
[l User Authentication Methods
i Min Worker Threads

LTI YY)

[l Max Session Count

(ll Max Session Timeout

[l Max Subcription Count

- Max Monitored Items Per Subscription
(W Opc Tep Connection Address

[l Server info

© session Info

= OpcUaNamespace

The Property Sheet view opens.

. OpcUaServer

,/ Property Sheet ~

{ok}

. true

Ok [08-Jan-24 1:13 PM IST]
Alarm Source Info

Ping Monitor

Tuning Policy Map

N Poll Scheduler
N40OpcUaServer

demo

D Use global certificate password
Opc Tcp Endpoint

[ Anonymous [] Username/Password [@] Certificate
8 [8-max]
500

+00000h 05m 00s &

50

10000

opc.tcp://

Opc Ua Build Info

No active sessions

Opc Ua Namespace

) Refresh

B Save

Step 9. Expand the Cert Alias And Password property, select a certificate from the Alias drop-down
menu, enter the private key Password and click Save.
The certificate is now available for Third-Party Clients.
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Chapter 3. OPC UA client tasks

The following topics describe how to set up the OPC UA client, connect to an OPC UA server, discover and
add points with alarm and history extensions and subscribe for OPC UA alarm events.

Adding the OPC UA network

An OPC UA network manages OPC UA devices, points, alarms and histories.

Prerequisites:
* The opcUaCore and opcUaClient modules are in the My Modules folder.
* The controller is licensed with the opcUaClient feature.

* You are connected to the Internet and working in Workbench running on a PC or laptop computer.

Step 1. Connect to the controller station.
Step 2. Open the opcUaClient palette (click the folder icon in the Palette sidebar).

Step 3. Inthe Workbench Nav tree, expand Config and double-click on the Drivers folder.
The Driver Manager opens.

Step 4. To add the network, click New.
The New window opens.

Step 5. Select OpcUaNetwork from the drop-down list and click OK.

Result

The driver adds the OpcUaNetwork to the station’s Driver Manager. The driver enables the network by

default. If this is an initial network setup, network Status will likely be {down} until you add an OPC UA
device and configure the server connection.

Related reference

opcUaClient-OpcUaNetwork

Connecting to an OPC UA server
The next step is to connect to the OPC UA server and add an OpcUaDevice to the network.

Prerequisites:

* You are working in Workbench running on a PC or laptop computer.
® Your OPC UA device is on the network and ready to connect.

® Prosys OPC UA Simulation Server is installed on the PC.

* Client Security Certificate (signed or self-signed) is generated or imported into the client station’s
CertManagerService. (For more details refer to the topics “Generating an OPC UA Client Certificate” and
"Generating an OPC UA Client Certificate for Third-Party Server”).

e Client User Identity Certificate (signed or self-signed) is generated or imported into the client station’s
CertManagerService. (For more details refer the topics “Generating an OPC UA Client Certificate” and
"Generating an OPC UA Client Certificate for Third-Party Server”).

Step 1. Open the OPC UA server software and navigate to the Status tab.
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Step 2.

Step 3.

Step 4.

The software opens.

-
Prosys OPC UA Simulation Server = | B |

Help

Status | Endpoints | Users | Sessions | Certificates | Connection Log | Address Space | Simulation | Debug Log | Reg/Res Log

OPC UA
Simulation Server

Server Status: Running
SIM |Connection Address (UA TCP): pc.tep MIEGTDTDVY XX C2 global ds. honeywell .com:53530/0PCUAISImulationServel
Connection Address (HTTPS): hitps:fIEG7DTDVYXXC2 global.ds.honeywell.com:53443/0P CUA/SimulationServer
@ Current Server Time: 2016-09-27 12:09:03+0530
Server Starting Time: 2016-09-27 12:08:30+0530
Running ve2.2.2-108

The example server software above is the ProSys Simulation Server. However, it is more likely
that you will open a connection to your OPC UA server using software known to you that serves-
up actual historical and live data.

Locate the Connection Address and copy it along with the required security mode and user
authentication method.

In the example above, this address
isiopc.tcp://IE67DTDVYXXC2.global.ds.honeywell.com:53530/0PCUA/
SimulationServer

Within Niagara the default configuration for the OPC UA server and client connections is
security mode Sign and SignEncrypt and security policy Basic256SHA256. These are the
recommended settings for high security. A warning accompanies the other security policies and
modes that the driver supports. You or an administrator must acknowledge this alert to proceed.
The driver logs the acknowledgment in the system for audit purposes.

NOTE: If the device fails to find the server at the requested address, it may be because the client
does not recognize the hostname. Consider adding the Hostname (IP address) to the hosts file.
You may also use the IP address instead of Hostname in the connection address, for example:
opc.tcp://127.0.0.1:53530/OPCUA/SimulationServer.

In the Workbench Nav tree, expand Config > Drivers and double-click OpcUaNetwork.
The Opc Ua Client Device Manager opens.

To add a new device, click New.
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MNew

Numberto Add

Type to Add ; OpcUa Device
1 [[1-100]

0K Cancel

The New window opens.

Step 5. Select OpcUaDevice from the drop-down list and click OK.

gl Name

"Ml Type

[l server Endpoint Url

[l security Mode

"Bl Security Certificate Alias

'@l Security Certificate Password

"@l User Authentication Mode

[l user Authentication Certificate Alias
[l User Authentication Certificate Password
. Username

'gi Password

‘@l Enabled

Name Type Server Endpoint Url  Security Mode Security Certificate Alias

i OpcUaDevice OpclUaDevice opctep://IEALLTDTKVGI Sign Ecript Basic256 Sha256  demodienteert

Opclalevice

Opc Ua Device

sneywell.com: 53533/0PCUA/SimulacionServer :f
sign &Encrypt/ Basic2565halse

democlientcert

LTI [] use global certificate password

Username and Password

default
[ use global certificate password
opcua PR
pesessssee
@ true
0K | Cancel

Security Certificate Pa

—-password--

A second New window opens.

Step 6. Configure the following required properties and click OK.
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* Server Endpoint Urlis the Connection Address you copied earlier.

® Security Mode, by default, is set to Sign Ecript Basic256 Sha256. This value must match
the server’s Security Mode configuration. The default Security Mode for both OPC UA
server and device is Sign Ecrypt Basic256 Sha256, which enables signing and encryption
with security policy EncryptBasic256SHA256.
® Security Certificate Alias defaults to the self-signed tridium certificate. For higher
security, use a signed client certificate that matches the root CA certificate in the station'’s
Trust Store.
¢ If Security Mode is selected other than None, then security certificates must be selected
from the station’s Key Store using the Security Certificate Alias drop-down list. You
must enter the private key password for the selected certificate in the Security
Certificate Password field.

* If Security Mode is selected as None, Security Certificate credentials remains same
cannot be modified.
® By default the User Authentication Mode is set to Username and Password . This value
must match the server’s supported authentication modes.

e If Username and Password is selected, enter the username in the User
Authentication Certificate Alias, password in the User Authentication
Certificate Password and the credentials remains same.

e If Certificate is selected, click the User Authentication Certificate Alias drop-
down to select the certificate and enter the private key password in the User
Authentication Certificate Password field.

Step 7. Expand Config > Services > PlatformServices and double-click CertManagerService.

Config Services PlatformServices CertManagerService 7 Certificate Management ~

Certificate Management

@ My Network Certificate Management for "localhost®

© LogHistoryservice User Key Store  System Trust Store  User Trust Store  Allowed Hosts

e ProgramService

° SearchService

© Tachictionaryservice Allowed Hosts 3 objects
TemplateService E o
e WebService

T PlatformServices
O Tepipservice
° LicenseService o global.ds. m TFXLS3F3 TueDec1912:34:47IST2023  SimulationServer@IE67LT
o CertManagerService

LT syslogplatformservice AErove

[E) view [ Approve [ Unapprove Delete

Hosts and host certificates that could not be validated:

Host Subject Approval Created Issued By -

9 127.0.0.1:53530 SimulationServer@IE67LTFXL53F3 FriJan 05 15:02:02IST 2024  SimulationServer@IE6TLT

9 127.0.0.1:52520 Niagara4 FriJan 0514:59:201ST 2024  Niagara4

The Certificate Management view opens.

Step 8. To approve the Security Certificate sent by the server as an exemption, click the Allowed Hosts
tab, right-click the host and click Approve.
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Approve Exemption(s) X
Areyou sureyou want to approve the selected exemption|(s)?

Yes No

The Approve Exemption(s) window opens.

You do not need to approve the exemption if the Server’s Security Certificate or the Signing
Certificate has been imported into the User Trust Store.

a. Select Yes to continue.

Step 9. To ping the server, right-click the OpcUaDevice and click Actions > Ping.

# Station:4912 (demoClient)
A ilarm
© confie Views
@ SErVices
6 Drivers

a MiagaraMetwaorl

Actions Ping

Learn

ﬂ OpcilaHetwork Reset Comm

ﬁ DpcUabevi
FRPEsTeE  Make Template

) A .
© 4pps ot
ﬁ o T R L ¥ e L

NOTE: If the OpcUaDevice is still unable to create a secure channel to the server, the server might
be rejecting the client’s certificate. You may need to approve or trust the client certificate in the
server's certificate store. Once you select the certificate, ping the server again.

Step10. Go to Property Sheet view of OpcUaDevice, and check the status of the following properties.
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. Config * Drivers . OpcUaNetwork . OpcUaDevice 7/ Property Sheet ~
~ Nav ; OpcUaDevice OC:rtManagerScrvice GOchAServer T TCP/IP Configuration E
E # C @ My Network Property Sheet
R Alarm @ OpcUaDevice (OpcUa Device)
© config (@ Status {unackedAlarm}
@ services M Enabled @ true
O orivers [l Fault Cause
O nisgaranenwork 2 Health Ok [12-Jan-24 12:04 PM IST]
O opcuaserver © Alarm Source Info Alarm Source Info

; OpcUaNamespace
° Alarm Source Info

f+ Poll Scheduler

N Poll Scheduler

i Server Endpoint Url opc.tep:// 1
O points [l Security Mode (Mode / Policy) Sign &Encrypt / Basic2565ha256
Alarm Bxt =
o Ul Security Certificate test
6 OpcUaNetwork = . .
= Ul User Authentication Mode Certificate
) m OpcUaDevice —
UMl User Authentication Certificate test
© Apps -
\Jll Server State Runnin,
e Files . =
& Hierarchy [ Server Current Time 12-Jan-2024 12:04 PM IST
y
@ History (W Server Start Time 12-Jan-2024 11:44 AM IST
’ - Timeout Interval 00000h 00Om 30.000s _—;Jl [1ms-<«inf]
(M Status Check Timeout 00000h 00m 10.000s 3 [1ms-+inf]

(W server Info

Opc Ua Build Info

Q Alarm Ext Opc Ua Client Alarm Device Ext
@ Points Opc Ua Client Point Device Ext
© Histories Opc Ua Client History Device Ext

01-Jan-1970 05:30 AM IST|¥ m

5 Refresh [ save

[l Initial History Archive From Date

The system should have populated these properties with current values.
® Server State shows Running.

® Server Current Time shows current timestamp. For example, 12-Jan-2024 12:04 PM
IST.

e Server Start Time shows server start time, For example, 12-Jan-2024 11:44 AM IST
* Server Info shows complete information of the server.
Product Name
Product Uri
Manufacturer
Software Version
Build Number
f. Build Date
Related reference

® & n T o

* opcUaClient-OpcUaDevice

Discovering OPC UA server points
Server point discovery interrogates the connected OPC UA server to discover the OPC UA objects.

Prerequisites:
You are working in Workbench running on a PC or laptop computer.

Step 1. Inthe Nav Tree, expand Config > Drivers > OpcUaNetwork > OpcUaDevice.
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; OpcllaDevice

ﬂﬁlla Wiews P OpcUa Client Point Manager
W Point Manager
AX Property Sheet

Wire Sheet

Property Sheet

Apps Make Template Category Sheet
&) Files AX Slot Sheet

(=] Hierarchy - Relation Sheet

Step 2. To open the Opc Ua Client Point Manager, do one of the following:

* Right-click the Points node and click Views > Opc Ua Client Point Manager and click Opc Ua
Client Point Manager.

* Double-click the Points node.
The Opc Ua Client Point Manager opens.

° /‘ OpclUa Client Discovery Success )) E
Discovered T objects
Ua Display Name Uz Node Id Access Level Array Dimension Array Index Ua Data Type Ua Data Type Identifier B
B Objects =85 o -1 f
O server i=2253 o -1 f
D MyObjects n==2;s=MyObjectsFolder { -1 f
D StaticData n==3;s=5taticData { -1 f
DNDnUaNodeComplianceTest ne==4:s=NonUaNodeComplianceTest {} -1 f
D Simulation ns=5;5=85/0:Simulation {1 -1 f
DMyBigNodeManager n==6;5=MyBigNodeManager { -1 f
Database 0 objects
MName Type Out UaMNodeld Arrayindex Ua StatusCode Tuning Policy Name =

[ New Folder ew * Edi iscover ance ® atc ag
K& New Fold N # Edit D M Cancel P Add Match  © Tagit

Step 3. To configure Discovery Preferences before discovering points, right-click Points, click Views > AX
Property Sheet and expand Discovery Preferences.

NOTE: Be sure to configure Discovery Preferences properties before attempting to discover
points. It is possible to unintentionally filter out points or data. Refer to the “opcUaClient-
OpcUaClientPointDeviceExt"” topic for details on these properties.
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The Property Sheet opens.

I Station . Config . Drivers I OpclaMetwork I OpclaDevice : Paoints / A¥ Property Sheet -

- Nav Property Sheet
#H O X ®Ow @ Points (OpcUa Client Point Device Ext)
ax - i li Discovery Preferences  Opc Ua Client Point Discovery Preferences
b 6 abstractMattDriverhetwork [l Do Not Ask Again @ tue
» @ Httpclient
L 6 MrioNetwork
e eAbstracthttDriverNetworkl
v 6 OpclaMetwork
v ﬁ OpclaDevice
o Alarm Source Info
B Pollscheduler
li serverinfo
o Alarm Ext
@ roints
o Histories

(@ show Addable Only @ true
(W Exclude Server @ e
li Exclude Types Folder .true

These properties control when the discovery prompt appears and which points a discovery job
leaves out of the resulting Discovered table.

Step 4. Configure preferences and click Save.

Step 5. To start the discovery job, double-click Points in the Nav tree and click Discover.
The discovery job communicates with the OPC UA server to discover the server's object structure.

Step 6. To browse the discovered objects, expand the items in the Discovered pane.

Step 7. To add points to the station database, select the points to add and click Add or double-click on
the selected object(s).
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The Add window opens.
F Y
4% Add S5
Name Type Ua Node Id Array Dimensions Array Index Enabled Facets |
MyLevel MWumericPoint ns=2;s=MyLevel true units=null,precision=2,min=-inf,max=+inf ¢
[ Name MyLevel
Ii Type Numeric Point
| . .
| [i Ua Node Id NumericPoint I-?
NumericWritable
Ii Array Dimensions ;_?
li Array Index I_?
li Enabled . true

[i Facets

[i Tuning Policy Name
li Device Facets

li Conversion

units=null,precision=2,min=-inf,max=+inf )) "9 -
Default Policy
units=null,precision=2,min=-inf,max=+inf )) ’9 -

= Default

oK | Cancel ‘

Step 8. If the point is writable, change the point Type to a writable type as shown above and click OK.
The driver adds the point(s) to a subscribed state and updates them with real-time values.

[+ /‘ OpclUa Client Discovery

Discovered
Usa Display Name
Bl Ohjects
Q Server
B Q) MyObjects
= D MyDevice
MyEnumObject
o MylLevel
&¥ MyMethod
QA Myswitch
Q) statichata

Database

Name Type Out

Mylevel MNumericPoint 88.00{ok}

Ua Node Id

i=85

i=2253
ns=2;s=MyObjectsFolder
ns=2;5=MyDevice
ne=2;5=MyEnumObject
nz=2;s=MyLevel
ne=2;s=MyMethod
ns=2:s=MySwitch

ns=3;5=5taticData

Ua Node Id Array Index

ns=2;s=MyLevel

Success >) E]

12 objects
Access Level Array Dimension Array Index Ua Data Type Ua Data Type Identifier B
-1
-1
-1
-1
{rw} Integer -1
{rw hr} Double 11
-1
{rwhr} Boolean 1
-1
1 objects
Ua Status Code  Tuning Policy Name B
GOOD (0x0000000 defaultPolicy I

If a point has engineering units, precision, and/or range information, the driver attempts to
configure the point’s facets to match. This may not always be possible.

Related reference

* opcUaClient-OpcUaDevice
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Adding points containing OPC UA histories

If the OPC UA point you are adding has an OPC UA history, the point automatically includes a history
extension (ImportHistoryExt).

Prerequisites:
Discovered objects with histories are visible in the Opc Ua Client Point Manager view.

Step 1.

Step 2.
Step 3.

Step 4.

Step 5.

40

To open the Opc Ua Client Point Manager, expand Config > Drivers > OpcUaNetwork >
OpcUaDevice and double-click the Points folder.

To run a discovery job, click Discover.

To confirm that the points have histories, examine them in the Opc Ua Client Point Manager.

&)  OpcUaclient Discovery

Discovered
Ua Display Name Ua Mode Id Access Le
B Objects i=85
Q) server i=2253
= OM}'ijEEtS ns=2;s=MyObject=Folder
= OM}'DE".'iEE ns=2:5=MyDevice
MyEnumObject ne=2;s=MyEnumObject [rw}
‘ 4 MyLevel ne=2:==MyLevel {rwhr}
{:,‘:' MyMethod ns=2;s=MyMethod
| 4 MySwitch ne=2:s=MySwitch {rwhr}

Here are two ways to identify OPC UA objects that have histories:

e A triangular history badge appears over the icon of the OPC UA object in the Discovered
pane, for example:

o MyLevel
® The value under the Historizing column in the Discovered pane reports true.

Select one or more objects with histories and click Add.
The default history extension period for uploading history data is once in 10 minutes. To modify
this period, configure the Execution Time property by changing the Interval value.

To view histories on the property sheet, right-click the point and click Views > AX Property Sheet.
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JaDevice AX Property Sheet

Alarm Source

Live History Chart

Poll Schedule
History Chart
Senver Info
History Table
Alarm Ext -
— History Summary View
gy Make Template Wire Sheet
o Property Sheet
[ nu Category Sheet
Histories AX Slot Sheet

serverRoot

opcUaClient-OpcUaClientHistoryDeviceExt

Importing OPC UA Histories without using a control point

The OpcUaDevice component’s histories extension (OpcUaClientHistoryDeviceExt can import OPC UA

histories without creating a control point.

WARNING: Be aware that you can duplicate an OPC UA history import by unintentionally using both the
OpcUaClientHistorylmport component and a control point with an ImportHistoryExt for the same discovered

object. Refer to “Adding points containing OPC UA histories.”

Step 1. Inthe Nav tree, right-click on Histories under the OpcUaDevice and click Views > Opc Ua Client
History Import Manager.

6 Drivers Views P | OpcUa Client History Import Manager
6 niagaranetwor eI Device Histories View
6 OpclaNetwork

Mew AX Property Sheet
; Opclabevig ’

Wire Sheet
(AP cdit Tags

Property Sheet

B¢+ Pollsc

Make Template Category Sheet
m Server = =
© alarm AX Slot Sheet
@D Points T Relation Sheet
O nistori SRS New View
— ik

Step 2. In the view, click Discover and wait a few moments for the job to run.
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Step 3. Select one or more histories to be imported and click Add.

42
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On completion, the discovery job displays a list of histories in the Discovered pane.

& Ndriver Discovery

Discovered

Ua Display Name  Ua Node Id
oA MyLevel ns=2;s=MyLevel
Q Myswitch ns=2:s=MySwitch

4 Counterl ns=5;5=Counterl

Array Dimension Array Index Mode Class Description

o Expressionl  ns=5;s=Expressionl

Database

Name Historyld Status State

Last Success Ua Mode Name Ua Nodeld TypeSpec

Variable
Variable
Variable

Variable

D New # Edit ” Discover M Cancel

(& Add

Type Spec

baja:Double
baja:Boolean
baja:Double

baja:Double

Local History Name

>-b Match

Ua Data Type Ua Data Type ldentifier UaVa B

Double 11
Boolean 1
Int32 6
Double 11

#i: Archive B Tagit

Success )) E]

10 objects

23.0
false
26

3.8747

0 objects

®

The Add window opens.

M -
4 Add

S5

& ns=2:s=MyLevel
& ns=2:5=MySwitch
li Name

[ History Id

l_‘ Execution Time

[l Enabled

[l capacity

[l Full Policy

[l ua Node Name
[l vaNode1d
[l Type Spec

l_‘. Local History Name

Name History Id  Execution Time

Enabled Capacity Full Policy

2:00 AM {Sun Mon Tue Wed Thu Fri Sat}  true

2:00 AM {Sun Mon Tue Wed Thu FriSat}  true

na=2;3=MyLevel

Time Of Day
Daily Randomizatio
Days Of Week

. true

Unlimited

Roll

MyLevel
ns=2;3=MyLevel
baja:Double

n3$3d253bss3dMyLevel

Unlimited Roll

Unlimited Roll

02:00:00 AM IST 4
n |(+00000h 00m 00s|2

[# sun [# Mon [ Tue [#] Wed [#] Thu [# Fri [#] 5at

OK

| Cancel |

a2

As

A

Al

Ua Node Name  Ua Node
MyLevel ns=2:5=N

MySwitch ns=2;5=M

Step 4. Modify properties to set up the history import as desired and click OK.
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Result
The driver imports the histories to the station’s history database at the time specified in the Execution Time
property.

Important note about OPC UA Histories

When you discover and add histories in the OPC UA client, they are automatically stored in two locations.
Adding histories using the History extension places them under the respective driver name within the history
section. Similarly, when you add a point with history to the Point device extension, it appears under the station
history.

Figure 2. OpcUa Histories

@ History

o JACE216_OPCUA
A AuditHistory
A BACnetTestFolderS2eBAChetBooleanOutput
A\ BrCnetTestFolders2eBACHetEnumOutput
A\ BrCnetTestFolders2eBACnetMumericinput
A LogHistory
A\ points/OPCUA_Bool_His
A\ points/OPCUA_Enum_His
A\ points/OPCUA_Mum_His
A\ points/OPCUA_ String_His

i OpcUaDevice
A\ pointz OPCUA_Bool_His
A\ points OPCUA_Enum_His
A\ points OPCUA_Num_His
A\ points OPCUA_String_His

Following is an explanation of two methods for importing histories from the OpcUa server into the client.

* OpcUaClientPointDeviceExt: When you identify a point with a history on the discovered OPC UA server
in the OpcUaClientPointManager view, adding this point to the station as a Niagara point will
automatically create an ImportHistoryExt as a subordinate to the control point. By default, these histories
are located under the station History.

* OpcUaClientHistoryDeviceExt: Each OpcUaDevice includes an OpcUaClientHistoryDeviceExt. This
device extension’s OpcUaClientHistorylmportManager view allows you to uncover all histories collected
by the connected OPC UA Server. When you discover and add these histories, the system retrieves and
stores the history of that particular point under the client driver name within the History.

Preferably, you should add histories to the Points device extension. However, it is possible to collect histories
without creating a Control Point by utilizing the Histories device extension..

OPC UA Client Histories

This topic explains how the OPC UA collects histories using the timestamps for the points.
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Starting with the Niagara 4.15 and Niagara 4.14.u1 releases, the OPC UA driver enables users to create and
manage historical data by storing time-stamped values. When an OPC UA server gathers historical data, it
collects two timestamps for each data point: the Source Timestamp and the Server Timestamp.

The OPC UA Client receives the Source and Server timestamps for proxy points. These two timestamps are
defined as follows:

Source Timestamp:

This timestamp is generated by the device or system, reflecting the time when the data was generated by
the source.

Server Timestamp:

This timestamp is generated by the server, indicating the time when the server received and stored the
data.

You can configure history records to use the Server Timestamp by setting the Use Server Timestamp property.

When importing histories, if you set Use Server Timestamp to true, the system will use the Server Timestamp.
If it is set to false the Source Timestamp will be employed instead.

When adding a new point with a history, navigate to the added point in the point database to configure the
Use Server Timestamp property within the point's history extension.
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Property Sheet

{) Random (Numeric Point)

- Facets

G' Proxy Ext
m= Qut
{3 hist

(M Status

units=null precision=2,min=-inf max=+inf >>
Opc Ua Client Proxy Ext
0.00 [stale}

Numeric Import History Ext
{ok}

[ Fault Cause

(@l Enabled

(@l History Name

(@ History Config
. Last Record

(@ state Idle

fi Execution Time 10 minutes {Sun Mon Tue Wed Thu Fri Sa...
(M Last Attempt 19-Nov-2024 07:16 AM EST

(Ml Last Success 19-Nov-2024 08:04 AM EST

0@l Last Failure 19-Nov-2024 07:07 AM EST

. true

$parent.name}

Ul Use Server Timestamp @ true

(@ Change Tolerance 0.00
( Precision 32 bit
(@ Min Rollover Value [# null 0.00
Ol Max Rollover Value [# null 0.00

Interval:irregular, Record Type: numeric...
08-5ep-1977 11:19 AM EDT |:| Hidden

Adding a control point to invoke an OPC UA method
The driver provides a means of invoking OPC UA method objects defined in a OPC UA server. My Method icon

.-_P MyMethad

) identifies discovered OPC UA methods.

Prerequisites:

OPC UA client tasks

-2.00

The discovered objects on the OPC UA server are visible in the Opc Ua Point Manager view.

Step 1. To open the Opc Ua Client Point Manager, expand Config > Drivers > OpcUaNetwork >
OpcUaDevice and double-click the Points folder.

Step 2. To run a discovery job, lick Discover.

Step 3. Select a MyMethod and click Add.
The driver adds the method in the Discovered pane to the database. The added control point now
has a callMethod action.

Step 4. Right-click on the method and click Actions > callMethod.
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If the method has defined input arguments, a Call Method window opens with the arguments.

i N
4% Call Method [
(@ Vector

. desch he operation to perform on parameter: wvalid functions are 3in, |

(Ml valued |tan
. descl The parameter for operation

(@ valuel |45.00

OK Cancel

L

A descriptor displays each argument. You may need to scroll the descriptor to see the complete
text.

Step 5. Enter the desired argument values and click OK.

Database
Name Type Out Ua Node Id Array Index Ua Status Code Tuning Policy Name
0 MyMethod OpcUaMethod 100{ck} n==2:=MyMethod defaultPolicy

The OpcUaMethod control point is a subclass of BStringPoint. The out property is a StatusString
type. The data type of the method return value may not be a string. In addition to setting the out
property by converting the method results to a string, the driver adds a Result property of the
appropriate BStatusValue type.

This invokes the method in the OPC UA server with the provided arguments.

Result
On completion, the Out property reflects and displays the control point.

OpcUaServer alarm acknowledgment processing

An OPC UA client can subscribe and receive OPC UA events from an OPC UA server. The OPC UA client
Alarm Manager may allow you to acknowledge a received event back to the OPC UA server. It may also allow
the user to command the OPC UA server to enable or disable the source of the received event.

The OPC UA server's OpcUaServerAlarmDeviceExt processes the Acknowledge, Enable, and Disable
commands. OpcUaServerAlarmDeviceExt is a child of each namespace component. Each OPC UA server
namespace has a frozen slot named AlarmExt. This extension is a type of OpcUaServerAlarmDeviceExt. It
keeps track of all of the alarmable points under this namespace. When the extension receives an Acknowledge
command for the OPC UA client, it attempts to locate the alarm record being acknowledged and
acknowledges the alarm. When the extension receives a Disable command, it disables the alarm from
generating any more OPC UA events from the associated control point until it receives an Enable command.

Subscribing for OPC UA alarm events

The OpcUaDevice component's Alarm Ext (OpcUaClientAlarmDeviceExt) component subscribes to OPC UA
alarm events.

Step 1. Inthe Nav tree, right-click on Alarm Ext under the OpcUaDevice and click Views > Opc Ua Client
Alarm Manager.
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Step 2. In the view, click Discover.
Discovery scans the Opc UA server looking for OPC UA variables that are capable of generating

alarms and displays them in the Discovered pane.

Success >) E]

° /‘ Mdriver Discovery

Discovered 1 objects
Ua Display Name Ua Node Id Array Dimension  Array Index MNodeClass Description TypeSpec UaData Type Ua Data Typeldentifier UaValue R
A MyLevel ns=2;s=MyLevel Variable baja:Double Double 11 23.0 Dot
Database 0 objects
i

Name UaModeld Enabled Subscribed LastEvent

[[) New | # Edit  §% Discover W Cancel (B Add = M Match = @ Tagit

Step 3. Select the variable to be imported and click Add.

The Add window opens.
i B
4% Add | 33 |
Name Ua Mode Id Enabled =

mHyLewel nz=2:==MylLevel true

E Name MyLewvel

E Ua Node ld n3=Z2;3=Mylewvel

E Enabled . true

OK | Cancel

Step 4. Modify properties as desired and click OK.
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The driver adds an OpcUaClientAlarmSource component to the station database.

O/‘ Mdriver Discovery Success )) E

Discovered 1 objects

Ua Display Name Ua Node Id Array Dimension Array Index Mode Class Description TypeSpec Ua Data Type Ua Data Type ldentifier Ua Value ®B

o MyLevel ns=2;s=MyLevel Variable baja:Double Double 11 23.0 Dai
Database 1 objects
Name Ua Node Id Enabled Subscribed LastEvent i
. Mylevel ns=2:s=Mylevel true true

[5] New ¢ Edit  §# Discover W cancel (@ Add | b Match @ Tagit

The Last Event column displays a summary of the last alarm event received from the OPC UA
server for the specified OPC UA node.

The added OpcUaClientAlarmSource component contains an AlarmSourcelnfo component.

Property Sheet
(@l MyLevel (OpcUa Client Alarm Source)
(@ status [ok}
(@l Enabled @ true
(@l UaNoded ns=2; s=MyLevel
(@l subscribed @ true
(@ Last Event 07-Nov-16 3:29 PM IST ns=2;3=Mylevel.Ala:
0 Alarm Source Info  Alarm Source Info
(@ Alarm Class Default Alarm Class
. Source Name iparent.displayNames @
(@l To Fault Text ©)

Step 5. Configure the AlarmSourcelnfo to route the received OPC UA alarm events to alarm recipients.

The Enabled property subscribes and unsubscribes to receive OPC UA alarm events on the
given OPC UA node.

When the node receives a new OPC UA alarm event it routes the alarm event through the
specified alarm class in the station’s AlarmService. The system then treats it as any other alarm.

Related reference

¢ opcUaClient-OpcUaClientAlarmDeviceExt
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Generating an OPC UA client certificate

This topic explains how to generate a client certificate using the added URI field in the certificate to establish a
secure server connection from the client to the server.

Prerequisites:

* The certificate is used for only OPC UA users only.

* Workbench running on a PC or laptop computer.

Step 1. To generate a certificate, expand Station > Config > Services > PlatformServices and double-click
CertManagerService

The Certificate Management view opens.

. Config I Services . PlatformServices . CertManagerService _/

Certificate Management ~

* Nav Certificate Management

# C ® My Network

o OrionAlarmService

Certificate Management for "localhost”

User Key Store  System Trust Store User Trust Store Allowed Hosts
W PlatformServices

. You have local certificates:
6 TeplpService
© Licensesenvice User Key Store 2 objects
0 CertManagerService : ; -
Alias Subject  Not After Key Algorithm  Key Size Valid B
6 Drivers
tridium Niagarad SatNov0517:17:051ST2022 RSA 2048 true
6 NiagaraNetwork
@ roints
© Histories
il serverRoot View @, New 5 Cert Reguest 4 Delete

@ Import % Export x Reset

Step 2. Click the New button at bottom of the view.
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The Generate Self Signed Certificate window opens.

Generate Self Signed Certificate X

Generate Self Signed Certificate
Generates a self signed certificate and inserts itinto the keystore

Alias

Common Name (CN)

Organizational Unit (OU)

Organization (0)
Locality (L)
State/Province (ST)
Country Code (C)

Mot Before
Not After

Key Size

Certificate Usage
Alternate Server Name
Alternate Server URI
Email Address

Key Usage

OPCUA (required)
OPCUA (required)

* this may contain the host name or address of the server

Acme (required)

IN (required)
11-Mar-2022 07:09 PM IST j
11-Mar-2023 07:09 PM IST _—;J'

O 1024 bits @ 2048 bits > 3072bits O 4096 bits
& Server $ Client O CA & CodeSigning

sal.acmecorp.com:0PCUA:NiagaraOpcUaClient

[ ] CRLsigning [[] Encipheronly [] Decipheronly

0K | Cancel |

Step 3. Give the certificate at least an Alias, Common Name (CN), Organization, Locality, State/
Province, and Country Code.
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Step 4.

Step 5.

Step 6.

Step 7.

* Use Alias to identify this as an OPCUA certificate.

® The Common Name (CN) becomes the Subject (also known as the Distinguished Name). For
OPCUA certificate, the Common Name (CN) may be the same as the Alias.

* Organization is the name of the company.

e Although Locality and State/Province are not required, leaving them blank generates a
warning message.

® The two-character Country Code is required and must be a known value, such as: US, IN, CA,
FR, DE, ES, etc. (refer to the ISO CODE column at countrycode.org).

* Not Before and Not After define the period of validity for the certificate.
* For Certificate Usage, the radio button should be set to Server.

Enter the URI in the Alternate Server URI field; it should be in the format:

OPC UA client tasks

urn:<full.computer.name>:0PCUA:NiagaraOpcUaClient and the select checkbox in the

Key Usage set to Data encipherment in the certificate.
NOTE:

* The full computer name can be found in Control panel > System & Security > System; it is of
the type hostname.domain or just hostname in some cases.

¢ While connecting from client to server, the URI provided in the client certificate should match
in the Application URI for the server. If doesn’t match the URI, it sends an error message as
Bad CertificateUriInvalid 0x80170000. The URI specified in the
Application Description does not match the URI in the certificate.

When you have filled in the required fields, click OK.
The Private Key Password window opens.

Private Key Password X

Private Key Password
Private Key Password

Password |

Confirm

[[] use global certificate password

0K Cancel

Enter and confirm the password, then click OK.

The system submits the certificate for processing in the background. A pop-up window appears
on your screen advising you that it may take time to generate the certificate. The length of time
takes depends on the key size and the platform’s processing capability. When created, the
certificate appears as a row in the User Key Store table.

To configure the certificate, open the device’s Property Sheet by right-clicking on OpcUaDevice
followed by clicking View > Property Sheet.
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The Property Sheet view opens.

~ Nav

'l o @ My Network
& My File System
O My Modules
8T Platform
, Station (TestOPCUA)
A alarm
6 Config
@ Services
6 Drivers
6 NiagaraNetwork
e OpcUaServer
6 OpcUaNetwork
; OpcUaDevice
© 4pps
Q Files
Hierarchy
0 History

Step 8.

. Station (TestOPCUA) . Config

Property Sheet
@ OpcUaDevice (OpcUa Device)
(@ status
(@l Enabled
[l Fault Cause
L] Health
© Alarm Source Info
e+ Poll Scheduler
i Server Endpoint Url
(W Security Mode (Mode / Policy)
(@ Security Certificate
(@ Alias test
(@ Password

(@l User Authentication Mode

. Username

[ Password

[ Server State

[l Server Current Time
[l Server Start Time

(M Timeout Interval

(M Status Check Timeout

enter the Password and click Save.

! OpcUaNetwork

OPC UA Driver Guide

: OpcUaDevice # Property Sheet ~

{down, alarm, unackedA.

@ tne

Fail [10-Jan-24 6:27 PM IST] Could not est...
Alarm Source Info

N Poll Scheduler

opc.tcp://|

Sign &Encrypt / Basic2565ha256

test

[ use global certificate password
Username and Password
OPCUA
sessssse
Unknown

null

000s|4 [1ms-+inf]

05|24 [1ms-=+inf]

5 Refresh [ save

Expand Security Certificate property, select the certificate from the Alias drop-down menu,

Generate an OPC UA Client Certificate for Third-Party Servers

The topic describes how to generate a client certificate using scripts by running the appropriate commands in
the command prompt or Git Bash to establish a secure server connection from the client to the server. To
ensure compatibility with OpcUaClient implementation, automatically uses a certificate for signing purposes
with the keyCertSign usage while generating the certificate.

Prerequisites:

* OpenSSL is installed on your system so that you can use the script file from the default windows command

line.

¢ Niagara station is running.

* The hostname is the full device name. To find the full device name in the Windows menu, choose Start >
Settings > System > About, and in Device Specifications you can find Full device name or from a
command line, type the following net config workstation, and you can find the string Full Computer name.

Step 1. To generate a certificate, follow the below choices.

* If you are using windows, open the command prompt, type the following command and

press Enter.

gen-opc-client-cert.bat

* If you are using Git Bash application, open the Git Bash prompt, type the following
command and press Enter.

./gen-opc-client-cert.bat

e If you are using Linux or WSL, open the command prompt, type the following command and

press Enter.

52

February 3, 2025



OPC UA Driver Guide

Step 2.

Step 3.

Step 4.
Step 5.

Step 6.

gen-opc-client-cert.sh

Prompts should appear in the Command Prompt (Terminal or Shell) window.

Follow the instructions displayed in the window, type the client hostname and press Enter.

EM C\Windows\System32\cmd.exe

Microsoft Windows [Version 1©.0.19845.3863]
(c) Microsoft Corporation. All rights reserved.

C:\Users\ "\Documents>gen-opc-client-cert.bat
Enter the client hostname [! ]: Acme.com
Enter certificate validity in days [365]: 364
Enter destination file [.\client.pem]: .\test.pem
s T i It B A i S
R R and

Verifying - Enter PEM pass phrase:

ou are about to be asked to enter information that will be incorporated
into your certificate request.

What you are about to enter is what is called a Distinguished Name or a DN.
There are quite a few fields but you can leave some blank

For some fields there will be a default value,

If you enter '.', the field will be left blank.

Country Name (2 letter code) [US]:IN

State or Province Name (full name) []:Karanataka

Locality Name (eg, city) []:Bengaluru

Organization Name (eg, company) []:Acme

Organizational Unit Name (eg, section) []:Engineering

Common Name (e.g. server FQDN or YOUR name) [Acme.com]:OPCUA
Email Address []:XYZ@Acme.com

Cert written to .\test.pem

Type the certificate validity in days and press enter.
NOTE: Based on requirements, you can specify duration for certificate validity.

Type the destination file name in the format .\yourCertName.pem and press Enter.

Type a random PEM Pass Phrase, press enter and verify the PEM Pass Phrase, press Enter.

OPC UA client tasks

The PEM passphrase can be any random passphrase with sufficient strength. Use the same PEM

passphrase throughout the procedure.

Type the following information and press Enter after each step.
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Step 7.

The two-character Country Code is required and must be a known value, such as: US, IN, CA,
FR, DE, ES, etc. (refer to the ISO CODE column at countrycode.org).

State/Province

Locality Name

Organization Name is the name of the company.
Organizational Unit Name

Common Name (CN)

Email Address

It displays Cert written to the destination and generates a certificate in the given destination file.

To import the PEM certificate, open Workbench, expand Config > Services > PlatformServices,
and click CertManagerService.

a. In the Certificate Management view, click Import, browse to the destination file and enter
the password, for decrypting the private key.

Private Key Password X

Private Key Password
Please enterthe password for decrypting the private key contained in the importfile.

Password |

oK Cancel
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Certificate Import

Certificate Import
Information forimported certificate OPCUA

EnterAlias

Tableview  ASN.1View

Properties:

Version

Serial Number
lssued By

IssuerDN

Subject

Subject DN

Not Before

Not After

Key Algorithm

Key Size

Signature Algorithm
Signature Size

Basic Constraints
Key Usage

Extended Key Usage
MDS5 Fingerprint

PEM View

v3

€éd ec 4a be c0 ¢b 8f 2d a7 07 9 b8 fb b4 ad 3e 42 4c £3 00
OFCUA
C=IN,ST=Karanataka, L=Bengaluru, O=Acme, OU=Engineering, CNl=0PCURA, E
OPCUA
C=IN,S5T=Karanataka, L=Bengaluru, O=Acme, OU=Engineering, CN=0PCUA,E
Wed Jan 10 17:43:23 IST 2024

Wed Jan 08 17:43:23 IST 2025

RSA

2043

SHR2S56WITHRSA

256

Subject Type: CA, Path Length Constraint: None

keyEncipherment, nonRepudiation, digitalSignature, dataEncipher
TLS Web Client Authentication (1.3.6.1.5.5.7.3.2)
08:b6:54:75:25:6a:16:90:e8:ae:32:£7:29:c1:d5:06

0K Cancel

The Certificate Import wizard opens.

b. To change the existing Alias, enter the new Alias name and click OK.

Private Key Encryption Password

Private Key Encryption Password
Please enter the password forencrypting the private key when savingitinto the key store,

Password |

Confirm

0K | Cancel

The Private Key Password window opens.

c. Type the Password, verify the Confirm password for encrypting the private key when saving
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it into the key store and click OK.
The certificate appears as a row in the User Key Store table.

OPC UA Driver Guide

Step 8. To configure the certificate, open the device’s Property Sheet by right-clicking on OpcUaDevice
followed by clicking View > Property Sheet.

. Station (TestOPCUA)

- Nav

t# O
b @ MyFile System
6 My Modules
& Platform
& station (TestoPCuA)
! Alarm
v 9Conf‘|g
» @ Services
v eDn‘vers
» 6 NiagaraNetwork
> 6 OpcUaServer
v 6 OpcUaNetwork

@ My Network

) 8 OpcUaDevice
> e Apps
Q Files
@ Hierarchy

@ History

The Property Sheet view opens.

=

. Config . Drivers

Property Sheet

OpcUaDevice (Opc Ua Device)
. Status
(M Enabled
[l Fault Cause
3 Health
© Alarm Source Info
e Poll Scheduler
@ Server Endpoint Url
[l Security Mode (Mode / Policy)
[l Security Certificate
:i Alias

fi Password

test

[l User Authentication Mode
.'i Username

[l Password

.'i Server State

(@ Server Current Time

(@l Server Start Time

(@l Timeout Interval

[ status Check Timeout

! OpcUaNetwork

. OpcUaDevice #  Property Sheet ~

{down, alarm,unackedA,

. true

Fail [10-Jan-24 6:27 PM IST] Could not est...
Alarm Source Info

N Poll Scheduler

opc.tcp://.

Sign &Encrypt / Basic2565ha256

test

[ use global certificate password
Username and Password
OPCUA
ssssssse
Unknown
null
null

7 Refresh

B Save

Step 9. Expand the Security Certificate property, select the certificate from the Alias drop-down menu,
enter the Password and click Save.
The certificate is now available for Third-Party servers.
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Opc Ua Reference

Chapter 4. Opc Ua Reference

The following topics provide conceptual information on the OPC UA security architecture, including
descriptions of the security policies, security mode, security profiles and user authentication.

Also covered is information on point type and facet mapping, server alarm processing and alarm
acknowledgment processing, links for third-party simulation software, as well as descriptions of the
components and views present in the opcUaServer and opcUaClient modules.

Point type mapping
The following table maps the OPC UA built-in data types to Niagara point types.

OPC UA Data Type

Boolean

SByte

Byte

Int16

Uint16

Int32

UInt32

Int64

Uint64

Float

Double

String

DateTime

Guid

ByteString
XmlElement
Nodeld
ExpandedNodeld
StatusCode
LocalizedText
ExtensionObject
Variant (array of)
Diagnosticinfo

Enumeration

Boolean Enum Numeric String
X

X X X X X X X X X X

x

Point facet mapping
The OpcUaClient driver will attempt to initialize facets for a point based on the setup of the OPC UA Variable

being proxied.

Control Point

BooleanPoint

EnumPoint

NumericPoint

Description

Will set the TrueText and FalseText if the OPC UA variable has "TrueState" and "FalseState"
properties.

Will set the EnumRange if the OPC UA variable has an "EnumStrings" property.

Will set the Units if the OPC UA variable has an EUInformation property and the Unit maps to a system
Unit. Will set the Precision, Max, and Min values based on the OPC UA variable data type or a
"Range" property if it exist for the variable.
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Components

Components include services, folders and other model building blocks associated with a module. You drag
them to a property or wire sheet from a palette. Views are plugins that can be accessed by double-clicking a
component in the Nav tree or right-clicking a component and selecting its view from the Views menu.

The component and view topics that follow appear as context-sensitive help topics when accessed by:

* Right-clicking on the object and selecting Views > Guide Help
¢ Clicking Help > Guide On Target

opcUaServer-OpcUaServer

This component contains the device-level OpcUaNamespace component and configuration parameters
necessary for communications with OPC UA client devices. Additionally, the OPC UA server point device
extension (OpcUaServerPointDeviceExt) of the OPC UA namespace adds points to the server. The
OpcUaServer palette houses this component.

NOTE: Starting with Niagara Niagara 4.14.u1 and Niagara 4.15, the OpcUaServer component provides access
to specific aspects of the OPC UA Server based on user roles and permissions as they are configured in the
User Service, Role Service and Category Service. These server-side settings are observed when granting access
to specific aspects of the OPC UA Server and include more restrictive access for Anonymous users. See OPC
UA server, client user authorization for more details.
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Figure 3. opcUaServer properties

. Config - Drivers . OpcUaServer

6 OpcUaServer

Property Sheet
6 OpcUaServer (OpcUa Server)
(@ Status {ok}
fi Enabled @ true
M Fault Cause
» [J Health Ok [24-May-22 10:14 AM IST]
» @ Alarm Source Info Alarm Source Info
» CJ Monitor Ping Monitor
» X Tuning Policies Tuning Policy Map
» B+ Poll Scheduler N Poll Scheduler
(Ml Opc Ua Server Name N40pcUaServer
» [l OpcTcp Endpoint Opc Tcp Endpoint
. User Authentication Methods [ Anonymous [#] Username/Password
(@ Min Worker Threads 8 [8-max]
. Max Session Count 500
(@l Max Session Timeout +00000h 05m 00s 3
(ll Max Subcription Count 50
Ul Max Monitored Items Per Subscription 10000
:i Opc Tcp Connection Address opc.tcp://IE4LLTDTKVGK3.global.ds.honeyw
» [ serverinfo Opc Ua Build Info
» © session Info No active sessions

To access these properties, expand Config > Drivers, right-click OpcUaServer and click Views > AX Property
Sheet.

In addition to the standard property (Enabled), these properties are unique to this component.

Property Value Description
Opc Ua Server text string Defines the name of the server. You may edit it or use the default name:
Name N4OpcUaServer.
additional Configures the Tcp Endpoint.
properties
Opc Tep Endpoint, true (default) or Enables (true) and disables (false) the use of a Tcp Endpoint.
Enabled false
Opc Tcp Endpoint, 52520 (default) Defines the port number for Opc Tcp connections.
Port
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Property

Opc Tep Endpoint,
Security Mode

Opc Tcp Endpoint,
Security Policies

User Authentication
Methods

Max Session Count

Max Session
Timeout

Max Subscription
Count

Max Monitored
Items Per
Subscription

Opc Tep
Connection
Address

Server Info

Session Info

Value

check boxes
(defaults to sign
and signEncrypt)

check boxes
(defaults to all)

check boxes
(defaults to all
except for
Z—\nonymous)

500 (default)

00001h 00m 00s
(default)

50 (default)

10000 (default)

read-only

additional
properties

additional
properties

OPC UA Driver Guide

Description

NOTE: The port specified in the Opc Tcp Connection Address may be
blocked by PC/network firewall. The firewall settings may need to be
adjusted to allow data transfer on this port.

Security mode of the application defines the security level for a
message being exchanged during communication between client and
server. The mode can be set to None, Sign, or SignAndEncrypt.

Specifies which security mechanisms are to be used for the Secure
Channel between client and server.

Selects a method for authenticating the user. These settings must
match the server’s settings for a successful connection.

Username and password values must be defined in the station’s
UserService.

certificate: Choose the certificate authentication and select the
CA or Intermediate Certificate (stored in User trust store) from
the drop down list. Please follow Setting up certificate based
authentication topic for more information.

NOTE: For Certificate creation and saving procedure, refer to
Station Security Guide.

All communications are done through sessions, which must be alive all
the time in normal cases. This property displays the maximum number
of session that can be live.

The server can close sessions that have not been active (no message of
any type from the client received for a more extended period than
SessionTimeout).

Displays the max number of subscription for a session.

Specifies the maximum number of monitored items per subscription.

Reports the connection address for the Opc Ua Server. The station must
be running for this field to be populated. This address includes the
specified port number for the Opc Tep Endpoint, for example
opc.tcp://ABCD1234.global.ds.honeywell.com:52520/

OPCUA/N40OpcUaServer

A separate topic documents these properties.

A separate topic documents these properties.
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Actions

* Ping sends a message to a network object (device, database, etc). The message provokes a response,
which indicates the current state of the object.

Related tasks

Setting up the OPC UA server

opcUaServer-OpcUaNamespace

This component provides a standard method for an OPC UA server to represent objects to OPC UA clients. It
defines objects in terms of variables and applicable attributes. It typically provides a logical grouping of OPC
UA variables, histories, and events that can be accessed by an OPC UA client.

To add server points to the OPC UA server, first add a namespace component. Within this namespace discover
points and add then points to the namespace. Once that is done, an OPC UA client can connect to the OPC

UA server and subscribe to all these points for monitoring.

This component is found in the opcUaServer palette.

Figure 4. OpcUaNamespace properties

. Station (NewEntSecSupervisor) . Config . Drivers / AY Property Sheet -

Property Sheet

# O ®) My Network @ OpcUaNamespace (OpcUa Namespace)
- - m Status {fault}
@ services (@l Enabled @ e
EDrivc—rs =
m Fault Cause Network fault: OPCULA Server capability m

6 MizgaraMetwork

L] Health Fail [null]
0 OECUESEWEF O Alarm source Info Alarm Source Info
g OpcUaNamespace @ Namespace Url http: //www. tridium. com/OFCUA/
O Graphics [ Mamespace Index -1

O customized Views [l Mamespace Folder Name

© Files [l Points Folder Name
@ Hierarchy Q Points Opc Ua Server Point Device Ext
O Alarm Bxt Opc Ua Server Alarm Device Ext

- Palette 7 Refresh [™] save

This device-level component resides under the OpcUaServer node.

In addition to the common properties (Status, Enabled, Fault Cause, Health and Alarm Source Info), these
properties are unique to this component.

Property Value Description
Namespace Url read-only Reports the URL of the namespace.
Namespace Index read-only
Namespace Folder Name text Defines the location of a folder.
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Property Value Description
Points Folder Name text Defines the points folder name.
Points container Opens the OpcUaServer Point
Manager.
Alarm Ext container Opens the OpcUaServer Alarm
Manager.

Related tasks

* Setting up the OPC UA server

opcUaServer-OpcUaServerPointDeviceExt

This component configures and provides the Opc Ua Server Point Manager. It is the OPC UA implementation
of the standard PointDeviceExt, a frozen device extension under every OPC UA server namespace.

Figure 5. OpcUaServerPointDeviceExt properties

. Station (NewEntSecSupervisor) . Config . Drivers . OpclaServer . OpclaNamespace . Paints / AX Property Sheet

- Nav Property Sheet

O () My Netwe € Points [Opc Ua Server Point Device Ext)
- - F. Discovery Preferences  OpcUa Server Point Discovery Preferenci..
6 OpclaServer

E Search Location station:|slot:/|bgl:select * from control:ControlPoint w - ’
2 OpcUaMamespace

0 Alarm Source Info

@ roints

[a JAETYES

(@l UaNode1d

- Palette

To access these properties, expand Config > Drivers > OpcUaServer, right-click Points and click Views > AX
Property Sheet.

Property Description
Discovery Preferences, Search ORD Identifies the location of the points
Location container in the station.
Ua Node Id read-only Reports the ID of the UA node.

opcUaServer-OpcUaServerAlarmDeviceExt

This component is a child of each Namespace component. Each OPC UA nerver namespace has a frozen slot
named AlarmExt that keeps track of all of the alarmable points under this namespace.

The default view for for this component is the Opc Ua Server Device Manager.

When the OPC UA client driver receives an acknowledgement, it attempts to locate the alarm record being
acknowledged and acknowledge the alarm. When the driver receives a disable command, it disables the alarm
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from generating any more OPC UA events from the associated control point until it receives an enable
command

Figure 6. OpcUaServerAlarmDeviceExt properties

. Alarm Ext / AX Property Sheet -

Nav Property Sheet

#H O () My Net © Alarm Ext (Opc Ua Server Alarm Device Ext)
- (@l Alarm Class Medium
v @ OpcUaNamespace (M Last Received Time |null

L™

¥ o Alarm Source Infc

» @ Points

- O alarmExt

+ Palette

To view these properties, expand Config > Drivers > OpcUaServer, right-click Alarm Ext and click Views > AX
Property Sheet

Property Value Description

Alarm Class drop-down list Specifies the alarm routing
option for the component.

Rreplace provides a selection list of
a local alarm classes, from which
to select one to use for all alarms
received from this device.

Use Existing routes alarms from
this remote station to any
matching alarm class, that is, one
with an identical name as that in
each alarm record. If the program
finds no local matching alarm
class, it uses the station's default
alarm class.

prepend adds leading text (as
specified) to the incoming alarm
class string, then routes it to any
local matching alarm class in the
station.
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Property Value Description

append adds trailing text (as
specified) to the incoming alarm
class string, then routes it to any
local matching alarm class in the
station.

Last Received Time read-only Reports the last time this extension
received an alarm.

Related tasks

Adding a server point with alarm and history extensions

opcUaServer-OpcUaServerDeviceFolder

This component is the OPC UA server implementation of a standard folder under the OpcUaServer container.
Typically, you add such folders using the New Folder button in the Opc Ua Server Device Manager of the
OpcUaServer. This component is also available in the opcUaServer palette.
opcUaServer-OpcUaServerPointFolder

This component is the OPC UA server implementation of a standard folder under the OpcUaNamespace >
Points container.

You add such folders using the New Folder button in the Opc Ua Server Point Manager of the OPC UA server
point device extension. ThisFolder is also available in the opcUaServer palette.

opcUaServer-OpcUaAlarmClass

This component groups alarms that have the same routing. It collects the alarms of OPC UA server points if the
alarm extension is configured.

This component is found in the opcUaServer palette. It goes on the AlarmService.
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Figure 7. OpcUaAlarmClass properties

My Modules I opcUaServer
- Nav
@ My Network

tf O
% AccessControlService
o AlarmService
A Medium
E ConsoleRecipient
A High
A Low
@ Off Alarm Class
E videoRecipient
A OpcUahlarmClass
E OpcUaAlarmRecipient
O ruditHistory

- Palette
w X

6 OpclaServer

E i opclaServer

© module.palette

© OpcUatlarmClass

Property Sheet

A OpcUaAlarmClass (OpcUa Alarm Class)
[#] toOffnormal [#] toFault [#] toMormal [] toAlert

(@il Ack Required

U@ Priority

@i Total Alarm Count
U@l Open Alarm Count
@il In Alarm Count

U@l Unacked Alarm Count
@il Time Of Last Alarm null
(@l Escalation Levell Enabled | false
@il Escalation Levell Delay
[@il Escalation Level2 Enabled
(@il Escalation Level2 Delay
@il Escalation Level3 Enabled
@l Escalation Level3 Delay

[ = T

.fﬂlsc—

.false

toOffnormal 255

00000h 05m|2] [1minute-+inf]

00000k 15m|4 [2 minutes-=+inf]

00000h 30m|% [3 minutes- +inf]
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#  BXProperty Sheet

toFault 255  toNormal 255  toAlert 255

To access these properties, expand Config > Services > AlarmService and double-click OpcUaAlarmClass.

Property

Ack Required

Priority

Total Alarm Count

Open Alarm Count

February 3, 2025

Value

check boxes (default to toOffNormal,
otFault and toNormal)

four fields for configuring importance

read-only

read-only

Description

Selects which conditions require
acknowledgment.

Define the priority level to assign
to the alarm class for each
component state transition (from
normal to offnormal, from normal
to fault, from normal to alert,
from offnormal to fault and from
alert to normal.

The lower the number, the more
significant the alarm. The highest
priority alarm is number 1.

Displays the total number of
alarms assigned to the alarm
Class from all sources.

Displays the current total number
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Property

In Alarm Count

Unacked Alarm Count

Time Of Last Alarm

Escalation Level(n) Enabled

Escalation Level(n) Delay

Value

read-only

read-only

read-only

true or false (default)

hours minutes (defaults to 3 minutes)

OPC UA Driver Guide

Description

of alarms that are
unacknowledged and normal or
unacknowledged and an alert.

Displays the total number of
alarm conditions.

Displays the total number of
unacknowledged alarms.

Displays when the system
generated the last alarm
assigned to this alarm ciass.

Turns this escalation level on
(true) and off (false).

Sets the time between alarm
generation and escalation. It is
not the time between escalation
levels. Set a time to allow an
unacknowledged alarm to remain
unacknowledged before you
escalate it to the next level.

opcUaServer-OpcUaAlarmRecipient

This component routes alarms to OPC UA clients and maps alarm conditions based on OPC UA Severity

settings.

This component is found in the opcUaServer palette.

66
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Figure 8. Opc Ua Alarm Recipient properties

. Station (NewEntSecSupervisor) . Config I Senvices . AlarmService . OpcUaklarmRecipient / AX Property Sheet
- Nav Property Sheet
#H O ) My Network kel OpcuaAlarmRecipient (OpcUa Alarm Recipient)
- - m Time Range 12:00 AM - 12:00 AM
@ Services [i Start Time 12:00:00 AM EST |3
% AccessControlService [i End Time 12:00:00 AM EST |4
© alarmservice [l Days Of Week [ sun [ Mon [ Tue [#] wed [# Thu [ Fri [ Sat
A Medium m Transitions [# tooffnormal [ toFault [ toalert
b consolerecipient (@l Route Acks @ ine
A High (W Status {ok}
MLom [i Fault Cause
Off &larm Class
g (@l Default Time Range | TimeRange 0?7 (O
videoRecipient
2 OpcUsalarml m Opc Ua Severity 700,900, 500, 600
& OpcUahlarmClass
Bl OpcUshlarmRecipient (@ ToOffnormal 700 [1- 1000]
pc rmRecipien
O rudithist (@ To Fault 900 [1-1000]
uditHistory
[l To Mormal 500 [1-1000]
0 AuthenticationService li
To Alert 600 [1-1000]

@ BackupService

- Palette 7 Refresh [M] save

To access these properties, expand Config > Services > AlarmService and right-click OpcUaAlarmRecipient and
click Views > AX Property Sheet.

In addition to the standard properties (Status and Fault Cause), these properties are specific to this
component.

Property Value Description

Time Range, Start and End Times time of day Sets the time of day to begin and
stop the function (for example,
trigger schedule, alarm event)

Days of the Week check boxes (all default to enabled) Specifies the days of the week to
include.
Transitions check boxes ( all default to enabled) Selects which alarm transitions to

display in the console. Only those
transitions selected display
although the station saves all
transitions in alarm history.

Options are: tooffnormal, toFault,
toNormal, toAlert
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Property

Route Acks

Default Time Range

Opc Ua Severity, To Offnormal

Opc Ua Severity, To Fault

Opc Ua Severity, To Normal

Opc Ua Severity, To Alert

Value

read-only

drop-down list

number (defaults to 700)

number (defaults to 900)

number (defaults to 500)

number (defaults to 600)

OPC UA Driver Guide

Description

Enables (true) and disables (fa1se)
the routing of alarm
acknowledgements to the
recipient. The framework does
not route trap (event notification)
acknowledgements if you select

false.

Selects the time range to use for
reporting alarms.

Assigns a severity index (integer)
based on the urgency of an alarm
event. By default, To Offnormal is
urgent.

Assigns a severity index (integer)
based on the urgency of an alarm
event. By default, To Fault is the
most urgent.

Assigns a severity index (integer)
based on the urgency of an alarm
event. By default, To Normal is the
least urgent.

Assigns a severity index (integer)
based on the urgency of an alarm
event. By default, To Alert is
moderately urgent.

opcUaServer-OpcUaAuthenticationScheme

This componentauthenticates the user on an OPC UA server, and ensures the password requirements are

adhered to. Any new OPC UA user should be associated with this scheme.

This component must be added to the station’s Authentication Service. Then, when creating a new OPC UA-
specific user, you configure the user’s authentication scheme as: OpcUaAuthenticationScheme.

NOTE: When making any changes on OPC UA server side, you must disable and then re-enable the OPC UA

server.
Property

Global Password Configuration

Password Strength

Expiration Interval

68

Value

container

container

365d 00h 00m 00s (default)

Description

Contains additional subproperties

Contains the subproperties
configured for a strong password
which requires a minimum of 10
characters; and at least 1of each of
the following characters: lowercase,
uppercase, digit.

Defines the period of time during
which the password is valid.
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Property Value Description
Warning Period 030d 00h 00m 00s Defines the period of time prior to
password expiration when a warning
is issued.
Password History Length 1-10 Configures the number of previously

used passwords to be retained. This
setting restricts the user from
reusing a set number of previously
used passwords. The range is 1-10,
with the default being 2.

Related tasks

Configuring the server to support an OPC UA client user
opcUaClient-OpcUaNetwork

The OpcUaNetwork is a top-level container component for an OPC UA network in a station. It represents a
network of manageable OPC UA client devices.

Within a network you can create multiple OPC UA client devices. This network provides a common monitor
that monitors the status of connected OPC UA servers. This component is available in the opcUaClient palette.
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Figure 9. OpcUaNetwork properties

. Station (NewEntSecSupervisor) . Config . Drivers . OpclaMetwork / A¥, Property Sheet -

- Nav Property Sheet
#H O ) My Networl  oOpcuaNetwork (OpcUa Network)
— . : (@ status [fault]
A Home (@il Enabled ® true
; Alarm [i Fault Cause Unlicensed: javax.baja.license.FeatureNo
© config [ Health Fail [null]
@ services © Alarm Source Info Alarm Source Info
6 orivers L] Monitor Ping Monitor
6 NiagaraNetwork X Tuning Policies Tuning Policy Map
6 DpcUaserver m Discovery Preferences  Opc Ua Client Device Discovery Preferenc...
 opcualetwork m Do Mot Ask Again . true
W OpcUaDevice & OpcUaDevice Opc Ua Device
O Grachics
- Palette 7 Refresh [™) save

NOTE: Starting with Niagara Niagara 4.14.u1 and Niagara 4.15, the OpcUaServer component provides access
to specific aspects of the OPC UA Server based on user roles and permissions as they are configured in the
User Service, Role Service and Category Service. These server-side settings are observed when granting access
to specific aspects of the OPC UA Server and include more restrictive access for Anonymous users. See OPC
UA server, client user authorization for more details.

Property Description

Discovery Preferences, Do Not Ask true or false (defaults to true)

Again

OpcUaDevice additional properties Documented in a separate topic.
Actions

* Ping sends a message to a network object (device, database, etc). The message provokes a response,
which indicates the current state of the object.

* Submit Discover Job discovers server objects.
¢ Dump Units
Related tasks

e Adding the OPC UA network
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opcUaClient-OpcUaDevice

This device-level component in an OPU UA network represents a client connection to a specific OPC UA server
and contains the configuration properties necessary for the driver to communicate with the server. The
OpcUaDevice has a points device extension (OpcUaClientPointDeviceExt) that contains all subscribed proxy
points.

Figure 10. OpcUaDevice properties

My ... . Station (NewEntSecSupervisor) . Config . Drivers . OpcUaNetwark . OpcUaDevice / AX¥ Property Sheet -
~ Nav Property Sheet
f#H o () My Netwark m OpcUaDevice (OpcUa Device)
- . - [l status {fault}
> & My File System (W Enabled @ e
’ OMyMDdUlES li Fault Cause Network fault: Unlicensed: javax.baja.lis
& Flstiorm » [ Health Fail [null]
v & station (NewEntSecSupenvisor ¥ @ Alarm Source Info Alarm Source Info
> # Home » B+ Poll Scheduler N Poll Scheduler
A alarm [l server Endpoint Url
+ © config [ Security Mode Sign Ecript Basic256 Sha256
> Servi
@ services (@ Certificate tridium
v eDrivers o
[l User Authentication Mode User Name And Password
» eNiagaraNc-twork
li User Name
b d eochaNr:twnrk
y ' E Gpaiancn [l Password
pcllaDevice
» O Graphics [l Server State Unknown
i 11
" 0 Customized Views li Server Current Time EE
b @ Files [ Server Start Time null
N [i Timeout Interval 00000R O0m 30.000s j‘ [1 ms-+inf]
[i Status Check Timeout 00000h O0m 10.000s3 ﬁ [1 ms-+inf]
- Palette » [@ serverInfo Opc Ua Build Info
» @ Alarm Ext Opc Ua Client Alarm Device Ext
] E] E i opcllaClient . ) ) )
b a Points Opc Ua Client Point Device Ext
b e DpcUaletwork p o Histories Opc Ua Client History Device Ext
bk a Opclabevice
» [ opcUabeviceFolder 5 Refresh B Save

The default view for an OpcUaDevice is the Opc Ua Client Manager.

In addition to the standard properties (Status, Enabled, Fault Cause, Health, Alarm Scorce Info, and Poll
Scheduler), these properties configure an OPC UA device.

Property Description

Server Endpoint Url URL Defines the connection address (URL) for the Opc Ua Server,
for example:
opc.tcp://IE67DTDVYXX.honeywell.com:52520/
OPCUA/N40OpcUaServer
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Property

Security Mode

Certificate

User Authentication
Mode

User Name

Password

Server State
Server Current Time
Server Start Time

Time Interval

Status Check Timeout

Server Info

72

Value

drop-down list (defaults
to Sign Ecript Basic256
Sha256)

drop-down list (defaults
to tridium)

drop-down list (defaults
to User Name and
Password)

text string

text string

read-only
read-only
read-only

hours minutes seconds
(defaults to 30 seconds)

hours minutes seconds
(defaults to 10 seconds)

additional properties

OPC UA Driver Guide

Description

Specifies what security should be applied to message
exchanges during a session.

Sign Ecript Basic256 Sha256 signs and encrypts all
messages. The signature or signing of the message
detects if it has been manipulated by any third party.
Sign Ecript Basic256

Sign Basic256 Sha256

Sign Basic256

Sign Ecript Basicl28Rsal5

Sign Basicl28 Rsalb

None

Selects the client’s TLS certificate. The default self-signed
certificate should be approved and used only until a signed
certificate is available.

Configures the type of user authentication. For a successful
connection, these settings must match the OPC UA server'’s
User Authentication Methods settings.

Anonymous

User Name and Password

Configures the user’s name. User authentication by User Name
and Password requires this property be set. The username and
password must be defined in the station’s UserService.

Configures the user’s password. User authentication by User
Name and Password requires this property be set. The
username and password must be defined in the station's
UserService.

Reports the current condition of the server.
Reports the current time as maintained in the server.

Reports when the server came online.

Displays read-only data read from the OPC UA server
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Property Value Description

configured for the device. These data are documented in a
separate topic.

Alarm Ext additional properties Opens the Opc Ua Client Alarm Manager. A separate topic
documents this component’s properties.

Points additional properties Opens the Opc ua Client Point Manager that contains device
point data. A separate topic documents this folder's related
discovery preferences.

Histories additional properties Opens the <Opc Ua Client History Import
Manager>. The Histories AX Property Sheet configures the
driver’s Retry Trigger. This typical set of properties are
documented in the Niagara Drivers Guide.

Actions
* Ping sends a message to a network object (device, database, etc). The message provokes a response,
which indicates the current state of the object.

® Learn discovers device objects.
* Reset Comm enables and disables the device (closes and reopens server connection).

Related tasks

Connecting to an OPC UA server
Discovering OPC UA server points

opcUaClient-OpcUaBuildInfo

This component is a child of each OpcUaDevice component. Each OPC UA device has a frozen slot named
Server Info (OpcUaBuildInfo) on the OpcUaDevice component.

This component displays read-only data read from the OPC UA server and configured for the device.

Figure 11. OpcUaBuildinfo properties

(@ Serverinfo (OpcUa Build Info)

(@ Product Name N4 CpclUaServer
. Product Uri urn:tridium.com: 0PCUA: N40pcUaServer
(@l Manufacturer Tridium

(@l softwareVersion  4.3.58.16
(@l Build Number 16
(@ Build Date 05/10/17 18:46:26.2290000 GMT

Property Description
Produce Name read-only Reports the name of the OPC UA
server.
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Property Value Description

Product Uri read-only Reports the URI (Uniform Resource
Identifier) for the server.

Manufacturer read-only Reports the name of the
manufacturer of the server.

Software Version read-only Reports the version of software for
the server.

Build Number read-only Reports a number for the server data
type.

Build Date read-only Reports a date and time of the

software build for the server.

Action
Update retreives the device data from the server.

opcUaClient-OpcUaClientAlarmDeviceExt

This component is a child of each OpcUaDevice component. Each OPC UA device has a frozen slot named
AlarmExt that is of type OpcUaClientAlarmDeviceExt.

The default view is the Opc Ua Client Alarm Manager.

This component provides the ability to subscribe to OPC UA alarm events. The view allows you to scan the
connected OPC UA server for OPC UA variables that can generate an alarm.

Figure 12. OpcUaClientAlarmDeviceExt properties

My ... I Sta.. ! Con... . Drivers . OpclaMetwork ! OpcUaDevice . Alarm Ext / AX Property Sheet -

Property Sheet

H O ) My Network © Alarm Ext (Opc Ua Client Alarm Device Ext)
_ (@ Alarm Class Medium
© 2larm Source Info m Last Received Time null
B¢ Poll scheduler (@l Auto Subscribe Enable | @ true
(g serverinfo Q Alarm Source Info Alarm Source Info
O larmext (@ Opc Ua Severity 700, 900, 500, 600

9 Points
o Histories

- Palette

To view these properties, expand Config > Drivers > OpcUaNetwork > OpcUaDevice, right-lick Alarm Ext and
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click Views > AX Property Sheet.

Opc Ua Reference

In addition to the standard properties that configure Alarm Source Info, these properties support the OPC UA

client alarm device extension.

Property Value
Alarm Class drop-down list (defaults to Medium)
Last Received Time read-only
Auto Subscribe Enable true (defaul)t or false
Opc Ua Severity read-only

Description

Specifies the alarm routing
option for the component.

Replace provides a selection list of
a local alarm classes, from which
to select one to use for all alarms
received from this device.

Use Existing routes alarms from
this remote station to any
matching alarm class, that is, one
with an identical name as that in
each alarm record. If the program
finds no local matching alarm
class, it uses the station's default
alarm class.

prepend adds leading text (as
specified) to the incoming alarm
class string, then routes it to any
local matching alarm class in the
station.

append adds trailing text (as
specified) to the incoming alarm
class string, then routes it to any
local matching alarm class in the
station.

Reports the time the last alarm was
received.

Turns automatic device subscription
on (true) and off (false).

Reports the configuration for the
four severity settings. For more
information, refer to opcUaServer-
OpcUaAlarmRecipient.

Related tasks

Subscribing for OPC UA alarm events
opcUaClient-OpcUaClientPointDeviceExt

This component is the OPC UA implementation of PointDeviceExt, a frozen device extension under every OPC

UA client device. Its primary view is the Opc Ua Client Point Manager.
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The OpcUaClientPointDeviceExt (Points) is also available in the opcUaClient palette.

Figure 13. OpcUAClientPointDeviceExt properties

My ... . Sta.. . Config . Drivers . OpcUaMetwork . OpcUaDevice . Points / AX Property Sheet -

Property Sheet

# O ) My Network € Points (Opc Ua Client Point Device Ext)

- [ Discovery Preferences  Opc Ua Client Point Discovery Preferences

ﬁ server Info ﬁ Do Not Ask Again '.' true
o Alarm Ext

o (M show Addable Only @ e

Points

O Histor (M Exclude Server ® e
ISTOnNes

[ L YT [l Exclude Types Folder @ true

- Palette

To access these properties, right-click Points, click Views > AX Property Sheet and expand Discovery
Preferences.

Property Value Description
Do Not Ask Again true (default) or false Controls when the discovery prompt
displays.

true displays the prompt when
you click the Discover button on
the Device Manager view.

false displays the prompt before
the system initiates the search.

Show Addable Only true (default) or false Controls the display of points that
cannot be added to the database.

true excludes the points that
cannot be added to the
database.

false displays the points that
cannot be added to the
database.

Exclude Server true (default) or false Controls the display of points
associated with the server.
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Property Value Description

true excludes the points
associated with the server.

false includes the points
associated with the server.

Exclude Types Folder true (default) or false Controls the display of points in the
Types folder.

true excludes the points in the
Types folder.

false includes the points in the
Types folder.

opcUaClient-OpcUaDeviceFolder

This component is the OPC UA client implementation of a folder under an OpcUaNetwork.

Typically, you add such folders using the New Folder button in the Opc Ua Client Device Manager view of the
OPC UA network. The component is also available in the opcUaClient palette.

opcUaClient-OpcUaClientHistoryDeviceExt

This component, whose default name is Histories, is a frozen device extension on the OPC UA client
component. It imports historical data from the OPC UA server into the station’s history space.

You use this components Opc Ua Client History Import Manager to add OPC UA client historylmport
descriptors.

Figure 14. OpcUaClientHistoryDeviceExt properties

. Station (NewEntSecSupervisor) > Config . Drivers . OpcUaNetwork ! OpcUaDevice . Histories / AX Property Sheet

- Nav Property Sheet

#t O () My Network O Histories (Opc Ua Client History Device Ext)
- Qll Retry Trigger 15 minutes {Sun Mon Tue Wed Thu Fri Sa...
m Serverinfo Interval 00000h 15m 00s|# [1ms-+inf]
© alamext (@ Trigger Mode  |Interval TimeOfDay [ StartTime|12:00:00 AM EDT | EndTime 11:59:59 EM EDT
@ roints Days Of Week [#] Sun [#] Mon [#] Tue [#] Wed [#] Thu [# Fri [ Sat
o Histories m Last Trigger 15-Mar-2021 11:42 RM EDT

- m Next Trigger 15-Mar-2021 11:57 EM EDT
- Palette fa
G Refresh D Save

For information about Retry Trigger properties, refer to the Niagara Drivers Guide.

Action
Retry downloads histories again.

February 3, 2025 77



Opc Ua Reference OPC UA Driver Guide

Related tasks

Adding points containing OPC UA histories
opcUaClient-OpcUaClientPointFolder

This component is the OPC UA cClient implementation of a folder under an OPC UA device Points extension.
You add such folders using the New Folder button in this component’s Opc Ua Client Point Manager. This
folder is also available in the opcUaClient palette.

This folder is also available in the opcUaClient palette.

opcUaServer-OpcUaServerDeviceManager

This manager is the primary view for the OpcUaServer component. It manages OPC UA namespace
components in the station.

Figure 15. Opc Ua Server Device Manager with added OpcUaNamespace

Database 1 objects

MName Type Exts Namespace Url Status Enabled Health =

i OpcUaMamespace OpclUaMamespace eo http:/fwww.tridium.com/OPCUA/OpclaMamespace {ok]} true Ok [31-May-17 11:1
£ New Folder | m New | Edit Taglt

To view, either double-click the OpcUaServer or right-click the OpcUaServer and select Views > Opc Ua Server
Device Manager.

Column Description

Name Displays the name of the namespace.

Type Displays the type of the namespace.

Exts Displays the device extension’s hyperlinks, including: Points, Alarms, Schedules, Trend Logs and
Config.

Name Displays the namespace Uri.

Uri

Status  Reports the current condition of the entity as of the last refresh: {alarm}, {disabled}, {down}, {fault},
{ok}, {stale}, {unackedAlarm}

Enabled |ndicates if the network, device, point or component is active or inactive.

Health Displays the current status of the device.

Buttons

* New Folder creates a new folder for devices. Each such folder provides its own set of manager views.
* New creates a new device record in the database.

* Edit opens the device's database record for updating.

* Taglt associates metadata, such as location or unique configuration with the object.
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Opc Ua Server Alarm Manager

This manager is the default view of the server alarms device extension (OpcUaServerAlarmDeviceExt as well as
the client alarms device extension (OpcUaClientAlarmDeviceExt).

Figure 16. Opc Ua Client Alarm Manager

. Station (NewEntSecSupervisor) . Config . Drivers . OpclaMetwork . OpclaDevice . Alarm Ext / OpcUaClient Alarm Manager

A
Database 0 objects

#f O @Mch—twork Name UaNodeld Enabled Alarm Class Subscribed Last Event c]

IQ- Poll Scheduler
[i Server Info
o Alarm Ext

@ add

» Match | & Tagit

* Palette B New _I‘ Edit “ Discover B Cancel

To view,double-clickthe Alarms extension, or right-click and selectViews > Opc Ua Server Alarm Manager.

Column Description

Name Reports the name of the entity or logical grouping.

Ua Node Displays the ID of UA Node.

Id

Enabled  [ndicates if the network, device, point or component is active or inactive.
Alarm Displays the alarm routing options and priorities.

Class

Subscribed Displays whether the device is subscriber or not.

Last Event Displays the summary of the last alarm event received from the OPC UA server for the specified OPC UA node.

Buttons
¢ New creates a new device record in the database.
* Edit opens the device’s database record for updating.

* Discover runs a discover job to locate installed devices, which appear in the Discovered pane. This view
has a standard appearance that is similar to all Device Manager views.

e Cancel ends the current discovery job.
* Add inserts into the database a record for the discovered and selected object.
® Match associates a discovered device with a record that is already in the database.

e Taglt associates metadata, such as location or unique configuration with the object.

Opc Ua Server Point Manager

This manager is the default view for the OpcUaServerPointDeviceExt (Points container) under an OPC UA
namespace. This is also the default view for any OpcUaServerPointFolder under the Points container of an OPC
UA namespace.

Bi-directional points

Starting in Niagara 4.15, the OPC UA Server supports bi-directional communication. One point is responsible
for sending data from the OPC UA Server, while another point is required to receive data from the client. With
this enhancement, a single point will manage incoming and outgoing data values.
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Two different ways to add the bi-directional points in the Opc Ua Server Point Manager
e While adding the bidirectional points from the Discovered pane, the import and export points are linked to

the local points

OPC UA Driver Guide

* Another way is adding the bi-directional points in the Database pane, by clicking through the New button.
These points are not linked to any local points.

Figure 17. Bi-directional points

Config : Drivers

: OpcUaServer

. OpcUaNamespace

»/ OpcUa Server Point Manage:

° /‘ OpcUa Server Discovery

Success >) E

- Nav
t# O ® My Network Discovered 6 objects
© config Point Direction Point Type B
@ services (D slot:/servi urityService/certif Bport  nssiCertificateExpiryPoint
e Drivers oslo(:‘Dnver;sOchaNerworksOp(UaDeul(e‘pmntss’Bomleanwntable Export control:BooleanWritable
6 NiagaraNetwork o;lo(: Drivers/Boolean/FanCommand Export control:BooleanWritable
e OpcUaServer 2] slot:/Drivers/Boolean/Pressure Export control:NumericWritable
@ OpcUaN
B s Oslot: Drivers/Boolean/SetPoint Export control:NumericWritable
° Alarm Source Info
slot: Drivers/Boolean/LessThan Export kitControl:LessThan
9 Paints
O Alarmext Database 4 objects
e OpcUaNetwork Name Out Ua Node Id Direction Local Point Local Point Slot  Tuning Polic B
O soolean (O BooleanWritable1 false {ok} @ def ne=2:s=points/B itablel Bidirectional null na defaultPolicy
() Numericwritablel 0.0 {ok} @ def ns=2:s=points/NumericWritable1 Bidirectional null na defaultPolicy
0 Pressure 11 @8 ns=2;s=points/ Export slot:/Drivers/Boolean/Pressure  out defaultPolicy
0 Pressurel 0.0 {stale} ns=2;s=points/Pressurel Import slot:/Drivers/Boolean/Pressure  in15 defaultPolicy

0 & New Folder | [ New | & Edit I #4 Discover I Wcancel  @Add | P match @ Tagt

Use this view to discover server points that exist in the station, which can be mapped to the
OpcUaServerPointFolder. Such server points are visible to a connected OPC UA client. Also, server points
provide live and historical data as well as alarm events.
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Figure 18. Opc Ua Server Point Manager view with discovered points added to station database
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To view, right-click a OpcUaServerPointDeviceExt or OpcUaServerPointFolder and select Views > Opc Ua
Server Point Manager

Column Description

Point Display the details of points.
Direction Displays the direction value.

Point Displays the type of the point added.
Type

Buttons
* New Folder creates a new folder for devices. Each such folder provides its own set of manager views.

¢ New creates a new device record in the database.

e Edit opens the device's database record for updating.

¢ Discover runs a discover job to locate installed devices, which appear in the Discovered pane. This view
has a standard appearance that is similar to all Device Manager views.

¢ Cancel ends the current discovery job.
e Add inserts into the database a record for the discovered and selected object.
* Match associates a discovered device with a record that is already in the database.

* Taglt associates metadata, such as location or unique configuration with the object.
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Opc Ua Client Device Manager

The Opc Ua Device Manager is the default view of a OpcUaNetwork, which helps to access OPC UA device
components.

Figure 19. Opc Ua Client Device Manager
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To view, right-click a OpcUaNetwork and select Views > Opc Ua Client Device Manager.

Column  Description

Name Reports the name of the entity or logical grouping.

Type Displays the type of device.

Exts Displays the device extension’s hyperlinks, including: Points, Alarms, Schedules, Trend Logs and
Config.

Status Reports the current condition of the entity as of the last refresh: {alarm}, {disabled}, {down}, {fault},
{ok}, {stale}, {unackedAlarm}

Server Displays the connection address (URL) for the Opc Ua Server.
Endpoint
Url

Security  Displays the security applied to message exchange during a session.
Mode

Certificate Displays the selected certificate.
Enabled |ndicates if the network, device, point or component is active or inactive.

Health Reports the status of the network, device or component. This advisory information, including a time
stamp, can help you recognize and troubleshoot problems but it provides no direct management
controls.

The Niagara Drivers Guide documents the these properties.

Buttons

* New Folder creates a new folder for devices. Each such folder provides its own set of manager views.
* New creates a new device record in the database.

* Edit opens the device’s database record for updating.

* Discover runs a discover job to locate installed devices, which appear in the Discovered pane. This view
has a standard appearance that is similar to all Device Manager views.

* Cancel ends the current discovery job.
* Add inserts into the database a record for the discovered and selected object.
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* Match associates a discovered device with a record that is already in the database.

e Taglt associates metadata, such as location or unique configuration with the object.

* Template Config accesses the station template that defines configuration options. You would select a
template to set up the device with pre-configured properties.

Opc Ua Client Alarm Manager

This manager is the default view of the client alarms device extension (OpcUaClientAlarmDeviceExt) as well as
the server alarms device extension (OpcUaServerAlarmDeviceExt).

This view allows you to scan the OPC UA server to discover and subscribe to OPC UA alarm events. For more
information, refer to “Opc Ua Server Alarm Manager.”

Opc Ua Client Point Manager

This manager is the default view for the OpcUaClientPointDeviceExt (Points container) under an OPC UA
device. This is also the default view for any OpcUaClientPointFolder under the Points container of an OPC UA
Device. Use this view to discover available points and add them to your station database.

Figure 20. Opc Ua Client Point Manager view with selected discovered points added to station database
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To view, right-click a OpcUaClientPointDeviceExt or OpcUaClientPointFolder and select Views > Opc Ua Client
Point Manager.

Column  Description

Ua Reports the name of the entity or logical grouping.

Display

Name

Ua Node Displays the ID of the UA node.

Id

Access Indicates the value of a variable can be accessed (read/write) and if it contains current and/or historic data.
Level

Array Displays the maximum supported length of each dimension. If the maximum is unknown the value shall be 0.

February 3, 2025 83



Opc Ua Reference OPC UA Driver Guide

Column  Description

Dimension

Array Displays the integer marker of the index of a particular value in an array type Node.
Index

Ua Data Displays the DataType attribute to a node of the data type NodeClass in the Server.
Type

UaData Displays the numeric identifier from the Data Type Node Id.

Type
identifier

Buttons

¢ New Folder creates a new folder for devices. Each such folder provides its own set of manager views.
* New creates a new device record in the database.

¢ Edit opens the device's database record for updating.

¢ Discover runs a discover job to locate installed devices, which appear in the Discovered pane. This view
has a standard appearance that is similar to all Device Manager views.

¢ Cancel ends the current discovery job.

* Add inserts into the database a record for the discovered and selected object.

* Match associates a discovered device with a record that is already in the database.
e Taglt associates metadata, such as location or unique configuration with the object.

Opc Ua Client History Import Manager

This manager is the default view for the OpcUaClientHistoryDeviceExt component, which discovers and
imports OPC UA histories without the creation of a control point.

To view, right-click a OpcUaClientHistoryDeviceExt and select Views > OpcUa Client History Import Manager.

Figure 21. OpcUa Client History Import Manager lists discovered points with histories
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Column Description

Ua Display Reports the name of the entity or logical grouping.
Name
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Column Description

Ua Node Displays the ID of the UA node.

Id

Array Displays the maximum supported length of each dimension. If the maximum is unknown the value shall be 0.
Dimension

Array Displays the integer marker of the index of a particular value in an array type Node.

Index

Node Class Displays the class of a Node in an AddressSpace.
Description Displays the information in the description attribute of a Node.
Type Spec Displays the Niagara Type Specification given to an OPCUA objects based on the type of data it encodes.

Ua Data Displays the DataType attribute to a node of the data type NodeClass in the Server.
Type
Ua Data Displays the numeric identifier from the Data Type Node Id.

Type
Identifier

Buttons
¢ New creates a new device record in the database.
* Edit opens the device’s database record for updating.

* Discover runs a discover job to locate installed devices, which appear in the Discovered pane. This view
has a standard appearance that is similar to all Device Manager views.

¢ Cancel ends the current discovery job.

* Add inserts into the database a record for the discovered and selected object.

* Match associates a discovered device with a record that is already in the database.
* Taglt associates metadata, such as location or unique configuration with the object.

* Archive archives the data.
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Chapter 5. Glossary

The following glossary entries relate specifically to the topics that are included as part of this document.
To find more glossary terms and definitions refer to glossaries in other individual documents.

Alphabetical listing

namespace

A container for node IDs (points in the framework). The OPC foundation specifies a predefined namespace
with index 0. Many more namespaces belong to specific OPC UA specifications, for example, DI and PLCopen.
Every OPC UA specification defines its own node IDs. (from https://stackoverflow.com).

The OpcUaNamespace component under the OpcUaNetwork node in the Nav tree configures the namespace.
The OpcUaServerPointDeviceExt component uniquely identifies each specific node.

severity
In OPC UA, alarm severity is specified by an integer range between 1 and 1000. An alarm severity map assigns
a level of urgency to each alarm event. An event that transitions:

¢ To Offnormal is urgent. By default it receives a severity index of 700.

* To Fault is the most urgent. By default it receives a severity index of 900.

* To Normal is the least urgent. By default it receives a severity index of 500.
* To Alert is moderately urgent. By default it receives a severity index of 600.
You can configure the severity index for each level of urgency.
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